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RESUMO 
 

A competição universitária Fórmula SAE Brasil demanda que os estudantes de engenharia 

projetem e construam um veículo de corrida, segundo um regulamento estabelecido pela 

associação organizadora (SAE Internacional). Nesse sentido, o presente trabalho tem por 

objetivo apresentar o projeto da suspensão do veículo da equipe Apuama Racing da 

Universidade de Brasília, bem como a modelagem preliminar em MSC ADAMS a ser 

utilizada nas simulações numéricas com vistas à melhoria da performance do veículo. Com 

base no projeto da suspensão, foi proposta uma estratégia de competição que consiste na 

avaliação da performance da suspensão, adaptada às principais provas dinâmicas 

estabelecidas no regulamento da competição. 

 
 
 
 

ABSTRACT 
 

The academic competition Formula SAE demand that engineering students to design and 

build a competition vehicle, according to the rules established by the organizing association 

(SAE International). In this sense, this study presents the suspension automotive design of the 

Apuama Racing team from University of Brasilia, as well as MSC ADAMS/Car preliminary 

modeling to be used in numerical simulations aimed at improving the performance of the 

vehicle. Based on suspension design is proposed a competitive strategy that consists in 

evaluating the performance of the suspension, adapted to the main dynamic tests established 

on the competition rules.  
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Anti-dive: Propriedade da suspensão de evitar que a dianteira do veículo se aproxime do solo sob 

frenagem. 

Anti-lift: Propriedade da suspensão de evitar que a traseira do veículo se afaste do solo em situações 

de frenagem. 

Anti-squat: Propriedade da suspensão de evitar que a traseira do veículo se aproxime do solo em 

situações de aceleração longitudianal. 

Camber: inclinação da roda com a vertical vista frontalmente. 

Caster: é a inclinação da linha, medida em relação à vertical, que liga os pontos externos dos braços 

superiores e inferiores da suspensão na vista lateral. 

Double A-arm: Modelo de bandeja de suspensão automotiva, semelhante à letra “A”. 
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Slip-angle: É definido como o deslocamento angular entre o plano de rotação da roda (direção na qual 

a roda está apontada) e o caminho de rolamento do pneu,ou seja, o percurso que o pneu se desloca no 

solo 
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1 – INTRODUÇÃO 
 

Este capítulo apresenta as considerações iniciais 

desse projeto, bem como sua contextualização, 

motivação e objetivos. 

 

 

 
 

1.1 – CONTEXTUALIZAÇÃO 

O sistema de suspensão veicular pode ser considerado como sendo um dos principais 

subsistemas presentes em um veículo. Sua função principal, na perspectiva do conforto, é isolar a 

estrutura e os passageiros das oscilações provocadas pelas irregularidades existentes nas estradas. Na 

perspectiva da segurança, ela visa garantir um permanente contato entre o pneu e a via de circulação. 

 Entretanto, no âmbito dos veículos de competição, a suspensão prescinde um pouco do 

conforto, a fim de garantir que a dinâmica veicular seja capaz de proporcionar o melhor desempenho 

durante a competição.  

 A competição Fórmula SAE acontece desde 1979 nos Estados Unidos e em 2004 começou a 

ser disputada no Brasil. Quem promove anualmente esse evento é a SAE International (Society of 

Automotive Engineers), com o apoio das outras SAE espalhadas pelo mundo. Além do Fórmula SAE, 

a SAE International promove também o Mini-Baja e o Aerodesign. Essas competições são fonte de 

inúmeras pesquisas que proporcionam aos estudantes de engenharia um aprendizado diferenciado por 

se tratar de problemas de ordem prática. Dentre os projetos voltados ao Fórmula SAE, podem ser 

citados alguns como: “Introduction to Formula SAE Suspension and Frame Design” de Gaffney E. F. 

e Salinas, A. R.; “Steering System and Suspension Design for 2005 Formula SAE-A Race Car” de 

Popa, C. E. (2005). 

1.2 – MOTIVAÇÃO 

A competição Fórmula SAE é organizada anualmente pela SAE Brasil com o intuito de fazer 

com que as universidades projetem e construam carros de corrida. Esse deve ser inovador ao menos 

em um item, propondo novas técnicas e tecnologias para o setor automobilístico. É por esse motivo 

que a equipe de Fórmula SAE da Universidade de Brasília, a Apuama Racing, trabalha em projetos de 

carros de competição desde 2004.  

1.3 – JUSTIFICATIVA 

Com vistas a se estabelecer uma competição saudável entre as universidades do país, a busca 

por um veículo com boa performance é o desejo de qualquer equipe participante. Neste sentido, o 

presente trabalho vem apresentar o projeto de uma suspensão passiva independente do tipo duplo A 
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(double A-arm) e realizar simulações numéricas, a fim de verificar sua performance a partir da 

verificação dos parâmetros de geometria de maior impacto no seu desempenho nas diversas provas 

dinâmicas que o carro é submetido no período da competição. Com base nos resultados das 

simulações, deverá ser proposta uma estratégia de competição que garanta um melhor desempenho do 

veículo baseado nos parâmetros de fácil ajuste da suspensão. 

1.4 – OBJETIVO 

 O objetivo desse trabalho é contribuir para o desenvolvimento de suspensão para o 

carro de competição na Fórmula SAE da Equipe Apuama Racing da Universidade de Brasília, bem 

como propor uma estratégia de competição baseada nos resultados das simulações no software 

ADAMS/Car. O intuito é que, a partir desse trabalho, a equipe possa ter um guia prático e simplificado 

para o projeto de suspensões. 

 O projeto da suspensão foi feito a partir das dimensões de um chassi pré-existente, que 

será utilizado no projeto da equipe para competição de 2011. Assim como o chassi, a suspensão está 

sujeita a um regulamento e a restrições de projeto que serão utilizadas durante sua execução. 

 

 

  



   3 

2 – SUSPENSÃO AUTOMOTIVA 
 

Neste capítulo serão apresentadas as definições 

básicas de uma suspensão automotiva, bem como 

um breve histórico do seu desenvolvimento. No 

final desse capítulo encontra-se um estudo do 

Estado da Arte da modelagem de uma suspensão 

do tipo passiva. 

 

 

2.1 - DEFINIÇÃO DE SUSPENSÃO 

Várias são as definições possíveis para uma suspensão automotiva. Das definições técnicas às 

populares pode-se citar algumas: 

 Mecânica: A suspensão de um automóvel é um conjunto de peças que, transferindo para 

os eixos o peso de um veículo, tem a função de amortecer os solavancos devidos à 

irregularidade do terreno [1]  

 A suspensão de um automóvel é o sistema responsável por absorver as irregularidades e 

impactos do solo, também serve para garantir que o pneu fique em permanente contato 

[2]. 

 A suspensão no automóvel é construída com vários componentes que integram um 

sistema muito eficiente para a geração de conforto, estabilidade e segurança na condução 

do automóvel [3]. 

 A função da suspensão de um veículo é maximizar o atrito entre os pneus e o solo, de 

modo a fornecer estabilidade na direção com bom controle e assegurar o conforto dos 

passageiros [4]. 

 A suspensão automotiva suporta o veículo nos seus eixos (Rajamani, 2005). 

 Isolamento das forças transmitidas por excitação externa é a questão fundamental de 

qualquer sistema de suspensão (Guglielmino, 2008). 

No fundo, todas as definições dizem o mesmo. Porém, é possível que surja alguma que por um 

pequeno detalhe seja mais completa. Entretanto, considera-se melhor ter uma gama de definições e 

cada indivíduo chegar a uma própria, do que fixar um conceito que possa ter interpretações diversas 

dependendo da experiência e necessidade. Por exemplo, a definição de uma suspensão automotiva 

para carros de passeio é, em vários pontos, diferente da definição para um carro de corrida. Dessa 

maneira, não iremos fixar nem utilizar somente uma definição padrão para suspensão automotiva. 
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2.2 - HISTÓRICO  

A suspensão de um automóvel é um dos principais responsáveis pela segurança e pelo 

conforto do motorista e dos passageiros. Muito tem sido feito para que cada vez mais se tenha 

segurança ao dirigir, principalmente no que diz respeito à qualidade e inovação dos componentes 

desse sistema. Várias dessas inovações que aparecem nos carros de passeio são derivadas de 

tecnologias criadas e testadas para carros de corrida de alto desempenho.  

Quando se trata de carros de competição de alto desempenho, um dos principais itens que 

afeta o carro é a suspensão. É ela, juntamente com a aerodinâmica do carro, que proporcionam o 

contato adequado com a pista, a dirigibilidade do automóvel durante as curvas e o controle necessário 

para que o piloto possa exigir o máximo da sua máquina. 

Fazendo um comparativo histórico, os primeiros carros de competição utilizavam eixos 

maciços simples que ligavam uma roda à outra, com um sistema de amortecimento por feixes de 

molas e borrachas. Esse tipo de suspensão não é independente como os modelos atuais. Com a 

melhoria dos amortecedores a óleo, as suspensões ficaram melhores e proporcionaram mais conforto e 

desempenho aos carros. Os primeiros carros, claro os Ford, utilizavam suspensão por feixe de molas 

similares aos utilizados há muito tempo pelos romanos em suas bigas e nas carruagens. Mesmo 

existindo há algum tempo, as molas helicoidais só foram utilizadas nas suspensões na década de 1930, 

montadoras como General Motors e Chrysler passaram a adotar esse tipo de mola na suspensão frontal 

de alguns de seus carros. 

Com o passar dos anos e com a necessidade cada vez maior de melhorar o desempenho dos 

veículos, os engenheiros das grandes montadoras e das grandes equipes de competição passaram a se 

aplicar um pouco mais no desenvolvimento de novos modelos de suspensão que pudessem melhorar 

os seus carros. Durante muito tempo, quando se falava em veículos de competição, pensava-se 

basicamente em motores cada vez mais potentes, porém percebeu-se um excelente ganho com 

pequenas alterações nos projetos de suspensão.  

Atualmente, utilizam-se basicamente dois tipos de suspensão na maioria dos veículos, tanto de 

competição quanto de passeio. Um deles é o sistema McPherson Fig. (2.1) em que há uma bandeja 

inferior com dois pontos de fixação no chassi e um na manga de eixo da roda, um ponto de fixação 

imediatamente superior ao conjunto mola-amortecedor, e outro é ligado na barra de direção. Esse 

sistema, além de muito eficiente, provê um enorme ganho de espaço, proporcionando um bom volume 

para a área do motor e evitando que o carro fique muito largo. Uma das desvantagens desse sistema é 

que, devido ao seu projeto, praticamente não há ganho de camber quando a roda se desloca para cima. 

Isso resulta em grande perda de capacidade de realizar curvas, porque quando o chassi rola para cima 

da suspensão, a roda rola para um camber positivo. 
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Figura 2. 1 - Suspensão McPherson [5] 

 

 

O outro tipo é conhecido como double wishbone, ou duplo A, Fig. (2.2). A forma dessa 

suspensão é exatamente como um A. É composta por dois braços triangulares, em que cada braço é 

fixado em dois pontos do chassi e um na manga de eixo que prende a roda. Há uma infinidade de 

combinações e disposições da mola e do amortecedor, na mais simples o conjunto mola-amortecedor é 

fixado no chassi e na extremidade do braço inferior. Esse tipo de suspensão é a mais utilizada em 

carros de competição, principalmente na categoria fórmula. 

A princípio, os braços dessa suspensão eram projetados com o mesmo tamanho e paralelos ao 

solo. Já nesta configuração levavam grandes vantagens em relação aos outros modelos de suspensão 

independente. Entretanto, esse sistema tinha o mesmo problema de ganho de camber positivo quando 

ocorre rolagem do chassi. Com isso, percebeu-se que os projetos tinham que trabalhar com ganho de 

camber negativo para poderem ter mais qualidade e melhorar o desempenho dos carros nas curvas. Por 

essa razão, esta suspensão hoje é projetada com os braços de suspensão com tamanhos distintos, onde 

o superior é sempre menor. 

 

 

 

 

 

 

 

  

Figura 2. 2 - Suspensão Double wishbone ou duplo A [6] 
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3 – SUSPENSÃO DOUBLE A-ARM 
 

Uma suspensão automotiva é composta por 

elementos físicos que, em sua disposição, 

respeitam uma geometria a qual é responsável 

pelo conforto e segurança dos ocupantes, além de 

garantir ao veículo um desempenho adequado, 

considerando um determinado contexto de 

utilização. Neste contexto, o objetivo desse 

capítulo é descrever, de maneira geral, os 

principais componentes de uma suspensão 

automotiva do tipo double A-arm, suas vantagens 

e desvantagens, bem como descrever o 

procedimento adotado para o projeto deste tipo 

de suspensão aplicado a um carro de competição 

Formula SAE. 

 

 

 

3.1 – OS PRINCIPAIS COMPONENTES DA SUSPENSÃO 

 Em geral, as suspensões automotivas são compostas por elementos bem conhecidos como 

molas, amortecedores, braços de suspensão ou bandejas e a manga de eixo. A Figura 3.1 mostra uma 

suspensão double A-arm  e seus principais componentes, que são apresentados sucintamente em 

seguida. 

 

 

Figura 3. 1 - Suspensão double a-arm [7] 
 

 

 Molas: são compostas basicamente por três tipos: molas helicoidais, barras de torção e feixes 

de molas. As molas helicoidais Fig. (3.2 - a) são comumente utilizadas em carros de passeio e 
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veículos leves. Em muitos casos, juntamente com a mola são utilizadas barras de torção Fig. 

(3.2 - c), que são barras de aço que conectam uma roda a outra ou diretamente no chassi e 

auxiliam a controlar a rolagem do carro. Já os feixes de molas Fig. (3.2 - b) são folhas de aço 

com comprimentos diferentes sobrepostas [8]. Independente da configuração ou do tipo, as 

molas têm uma função básica: armazenar energia, ou seja, em uma suspensão automotiva elas 

devem absorver os choques provocados pelas irregularidades das pistas (Alexander, 1991). 

Nesse trabalho serão utilizadas molas helicoidais. 

 

(a) 

 
 

(b) (c) 

Figura 3. 2 - Tipos de mola: (a) Molas helicoidais; (b) Feixe de molas; (c) Barra de torção. (Halderman, 

1996) 

 Amortecedores: os amortecedores têm a função de dissipar a energia armazenada pelas molas 

durante um percurso. Se um veículo tivesse somente molas, iria oscilar muito a ponto de 

deixar os ocupantes fisicamente debilitados. Além de controlar a oscilação, é responsável 

também por manter uma certa distensão da suspensão (distância mínima entre rodas e chassi), 

a fim de proporcionar um nível de oscilação para as condições da estrada e deixar as rodas 

com o maior contato possível durante o percurso [8]. (Dixon, 2007) mostra que, 

historicamente, a necessidade por amortecedores surge por causa dos movimentos de rolagem 

e oscilação da roda em função das manobras dos veículos e das irregularidades das estradas, 
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principalmente com o surgimento dos automóveis. Desde sua criação, os amortecedores vêm 

passando por várias evoluções em que as principais etapas são: 

o Atrito seco ou retentores; 

o Blow-off hydraulics ou sopro hidráulico; 

o Hidráulico progressivel; 

o Ajustáveis (manualmente); 

o Adaptáveis lento (alteração automática); 

o Adaptáveis rápido (utilizados em suspensões semi-ativas); 

o Magnetoreológico; 

Nesse trabalho serão utilizados amortecedores do tipo hidráulico progressível ajustáveis Fig. 

(3.3), pois possuem excelente desempenho e são relativamente mais baratos. 

 

 

Figura 3. 3 - Amortecedor hidráulico progressível ajustado da marca OHLINS [9] 

 

 Braços de suspensão ou bandejas: É a principal característica de diferenciação entres os tipos 

de suspensões independentes. A função dos braços é limitar o movimento da roda, para isso 

cada componente é responsável em restringir no mínimo um grau de liberdade (gdl). A 

utilizada nesse trabalho, a double A-arm, é composta por dois braços triangulares com dupla 

fixação no chassi e a outra fixação na manga de eixo. Esse tipo de suspensão é comumente 

encontrada em carros de competição ou de alto desempenho. No caso da double A-arm, cada 

braço restringe dois gdl, como são dois braços, tem-se o total de quatro restrições. 

Considerando que em um sistema cartesiano (três eixos x, y, z) tem-se seis gdl, para completar 

a quinta restrição, utiliza-se uma junta com a manga de eixo. Dessa maneira, só resta um gdl 

para a roda. O outro tipo de suspensão mais comum é a MacPherson, que é encontrada na 

maioria dos carros de passeio. No caso da MacPherson, a bandeja inferior restringe dois gld, o 

conjunto mola-amortecedor montado na bandeja inferior e no chassi bloqueia mais um gdl e 

da mesma forma do anterior, o último gdl restrito é feito pela barra de direção. 
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Figura 3. 4 - Suspensão McPherson [10] 
 

 

 Manga de eixo: É responsável pela fixação da roda no sistema de suspensão Fig. (3.1) e Fig. (3.4), 

pela conexão com o sistema de direção e pelo suporte do sistema de frenagem. Além disso, é 

responsável também por algumas características geométricas como camber, caster, kingpin angle 

e outros que serão discutidos no próximo item.  

A suspensão double A-arm  é a adotada no trabalho devido à facilidade de construção, por ser uma 

suspensão compacta, leve e de fácil ajuste. 

 

3.2 – GEOMETRIA DE SUSPENSÃO 

 As relações geométricas influenciam diretamente no desempenho da suspensão e 

dirigibilidade do veículo. Essas relações determinam as forças a que os pneus/rodas serão submetidos, 

consequentemente, determinam todas as características geométricas do conjunto. A seguir, serão 

apresentadas as principais relações geométricas que compõem uma suspensão. A maioria dos termos 

utilizados estão em inglês e devido à dificuldade de uma tradução adequada, não são traduzidos. 

 A literatura de base para o desenvolvimento dos itens a seguir é Milliken & Milliken (1995). 

Quando necessário, outras referências são citadas. 

 

3.2.1 - CENTRO INSTANTÂNEO 

 O Centro Instantâneo de Rotação é uma representação gráfica de um pólo formado pelo 

prolongamento dos links que compõem a suspensão em um instante qualquer. Como dito em 3.1, os 

links fornecem restrições de movimento a este subsistema. Quando prolongados, ao convergirem para 

um ponto, geram em um determinado instante um grau de liberdade de rotação momentâneo em torno 

deste pólo, denominado CI. Dessa maneira, define-se um ponto que representa o ponto de rotação do 
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sistema de suspensão, conforme mostrado na Fig. (3.5). Este é um parâmetro importante, pois vários 

outros parâmetros básicos para o projeto de uma suspensão são derivados deste. 

 No projeto de suspensão é conveniente ter uma visão espacial do problema em duas vistas, 

frontal e lateral, obtendo, portanto, um sistema de duas dimensões. Nestes dois planos é possível 

verificar o posicionamento do CI em vista frontal e lateral, tendo que a união dos dois pontos fornece 

o eixo instantâneo de rotação, ou seja, o eixo em que, em um instante qualquer, ocorreria a rotação do 

corpo Fig. (3.6). Enfim, faz-se referência ao CI quando se trabalha com o sistema em duas dimensões, 

já o eixo instantâneo é considerado quando se considera o sistema em três dimensões. 

 A distância da projeção do CI na direção horizontal, até o eixo central da roda do veículo, é 

denominada comprimento do braço articulado. A distância da projeção do CI na direção vertical até o 

solo fornece a altura do CI. 

 

Figura 3. 6 - Eixo instantâneo (Milliken & Milliken, 1995) 

 

Sabe-se ainda que a geometria da suspensão de um veículo depende, em alguns aspectos, 

daquilo que se deseja priorizar em termos de performance. Em vista disto, para suspensões 

independentes como a deste trabalho é necessário estabelecer dois centros instantâneos, o frontal e o 

 
 

Figura 3. 5 - Centro Instantâneo de rotação (Ref.: Milliken & Milliken, 1995) 
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lateral, a fim de estabelecer as propriedades básicas que vão caracterizar este subsistema. Para tanto, 

inicia-se pelo estudo da geometria do FVSA (front view swing arm) e em seguida da SVSA (side view 

swing arm). Os itens 3.2.2 e 3.2.3 tratam de cada uma destas geometrias. 

Portanto, a localização do CI na vista frontal – FVSA permite a definição da variação do 

ângulo de camber, da altura do centro de rolagem relativamente ao solo e do scrub motion devido ao 

movimento vertical das rodas. A avaliação da vista lateral - SVSA permite controlar forças e 

movimentos relativos ao anti-lift, anti-dive/squat e a taxa de variação de caster.  

 

 

3.2.2 - GEOMETRIA DO FVSA 

3.2.2.1 - ALTURA DO CENTRO DE ROLAGEM 

 Uma vez definidos os CI’s através do prolongamento dos links que formam as bandejas, item 

3.2.1, cria-se uma linha auxiliar que liga o centro do contato do pneu com o solo ao CI frontal. Isso é 

feito para os dois lados, segundo o seguinte critério: centro de contato esquerdo com o CI da esquerda, 

e centro de contato direito com o CI da direita. Dessa maneira, onde essas linhas se interceptarem tem-

se o centro de rolagem relativo ao solo. Sua altura é medida na vertical conforme Fig. (3.7) 

 

Figura 3. 7 - Construção do centro de rolagem (Milliken & Milliken, 1995) 
 

 

O centro de rolagem estabelece o ponto de acoplamento das forças entre as massas suspensas e 

não suspensas. Quando o carro faz uma curva, a força centrífuga aplicada no centro de massa tem 

reação nos pneus. Essa força lateral pode ser levada ao centro de rolagem, sendo representada pela 

força e seu momento. Quanto mais alto o centro de rolagem (mais próximo do CG), menor o momento 

de rolagem transmitido e ocorre a transferência de forças para os pneus, em que parte dessa força é 

lateral. Isso faz com que haja uma redução na tração e causa o chamado efeito jacking. Se o centro de 

rolagem estiver mais próximo do solo, ou abaixo, ocorre a transferência de peso da massa suspensa 

para as molas e barras como força vertical, (Alexander, 1991). 
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3.2.2.2 - TAXA DE VARIAÇÃO DO ÂNGULO DE CAMBER 

A taxa de variação de camber é função somente do comprimento do fvsa Fig. (3.8) e é 

definido como sendo a variação da inclinação da roda (variação de camber) por mm, ou polegada, de 

curso da roda, o qual é diferente do conceito de camber estático (ou alinhamento), e será explicado na 

seção 3.3.4.1. Quanto maior o comprimento do fvsa (em mm) menor é a variação de camber, de 

acordo com a Eq. (3.1).  











fvsadoocompriment
camberângulodoVariação

1
arctan  Eq. 3.1 

 
 

Figura 3. 8 - Variação de camber (Milliken & Milliken,1995) 

 

 

3.2.2.3 – SCRUB 

Outra variável da vista frontal é o scrub da roda, que consiste em um movimento lateral desta 

relativamente ao solo, o que resulta no movimento vertical dos pneus. O scrub é função do tamanho 

dos braços de controle da suspensão e da altura do CI em relação ao solo. Quando o CI está em 

qualquer posição que não seja a do nível do solo há o aumento do scrub.  

Em uma superfície rugosa ou ondulada o trajeto do pneu não é uma linha reta se houver scrub 

Fig. (3.9). Quantidades significativas de scrub introduzirão velocidade lateral, que adicionado à 

velocidade frontal, mudará o ângulo de escorregamento do pneu (slip angle). Esse efeito prejudica a 

dirigibilidade e a estabilidade do carro tanto nas retas, quanto nas curvas.  

 

Figura 3. 9 - Percurso do pneu em uma pista irregular com grande quantidade de scrub (Milliken & 

Milliken, 1995) 
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3.2.3 - GEOMETRIA SVSA 

 O svsa controla os movimentos e forças na direção longitudinal do veículo. Os parâmetros 

típicos de controle são: anti-dive, anti-lift, anti-squat. O svsa pode admitir posições à frente (ou atrás) 

e acima (ou abaixo) do centro da roda (wheel center), para suspensões independentes dianteiras e 

traseiras. Em geral, o centro instantâneo se localiza atrás e acima do centro da roda nas suspensões 

dianteiras, e atrás e acima do centro da roda para a maioria das suspensões traseiras.  

 

3.2.3.1 - EFEITOS “ANTI” 

Os efeitos “anti” em uma suspensão descrevem a relação das forças longitudinais e verticais 

entre as massas suspensa e não suspensa. Desta maneira, calculam-se os efeitos “anti” para estimar o 

comportamento do carro sobre situações de aceleração e frenagem. A transferência total de cargas 

longitudinais sob ação de aceleração ou frenagem é função dos parâmetros: 

 Distância entre eixos (l); 

 Altura do centro de gravidade (h); 

 Força de frenagem ou aceleração:                        ; 

O anti-dive, ou anti-mergulho, reflete a situação em que as molas, juntamente com a estrutura 

da suspensão, reagem a uma frenagem. Se uma suspensão tem 100% de anti-dive, toda a força 

longitudinal é transferida para os braços da suspensão, ou seja, nenhuma carga é transferida para as 

molas. No entanto, se o projeto previr 0% de anti-dive toda a força é transferida para as molas e 

nenhuma carga para a estrutura. O anti-lift ocorre na suspensão traseira na situação de frenagem, 

quando ocorre o levantamento da suspensão. Um anti de 0% é obtido quando F Fig. (3.10) e R Fig. 

(3.11) são iguais a zero. 

Utiliza-se o valor do ângulo de anti-dive como um dos parâmetros para o cálculo da altura do 

CI lateral, o qual pode ser obtido de duas maneiras. Na primeira, estima-se um valor desejável para 

esse efeito em função do ângulo F (Fig. 3.10), e em função de uma altura desejável para o svsa 

obtêm-se uma altura desejada do CI. Dessa maneira, obtém-se os pontos de ancoragem da suspensão 

no chassi de maneira reversa à apresentada na seção 3.2.1. 

Na segunda maneira, parte-se dos pontos de ancoragem, com o prolongamento da linha que 

liga esses pontos e estima-se o CI e, assim, chega-se ao valor de F. O processo escolhido nesse 

projeto foi o segundo em função das dimensões do chassi já existente. Os detalhes da vista lateral, das 

dimensões e dos cálculos encontram-se no Capítulo 4, em que se faz o detalhamento do projeto 

preliminar da suspensão adotada.  

Os métodos de cálculo dos efeitos apresentados acima foram baseados na interpretação da 

metodologia utilizada por Milliken e Milliken, 1995, por entender que a maneira apresentada é mais 

simples, de fácil entendimento e, devido à metodologia que será apresentada nesse capítulo, pode 

proporcionar uma maior compreensão dos efeitos causados pela sua alteração. 
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Figura 3. 10 - Ângulo anti-dive (Milliken & Milliken, 1995) 

 

Para a traseira tem-se ainda o parâmetro anti-squat que é a reação da suspensão traseira à 

aceleração. Para seu cálculo utiliza-se o CI obtido pelo prolongamento das linhas que ligam os pontos 

de fixação da suspensão traseira. Desenha-se uma linha que vai do ponto de contato do pneu até o CI 

traseiro. Assim, temos o ângulo R que é utilizado para calcular o percentual de anti-squat Fig. (3.11). 

 O anti-lift também depende do ângulo R. Esse parâmetro é a reação da traseira do carro a 

situações de frenagem. No momento que o carro é submetido a uma frenagem a dianteira tende a 

mergulhar de encontro ao solo (anti-dive), portanto, a traseira tende a levantar. O quanto a suspensão 

reage a essa situação é função do ângulo R e sua interpretação é feita do mesmo jeito que é feito para 

o anti-dive, ou seja, quanto maior o valor do anti-lift, maior a força de reação exercida pelos braços da 

suspensão. 

 

3.2.3.2 - TAXA DE VARIAÇÃO DE CASTER 

Assim como a variação do camber na vista frontal, a variação de caster é puramente função do 

comprimento do svsa. Mais detalhes sobre caster e as conseqüências da variação desse item serão 

vistos na seção 3.2.4. 

 

3.2.4 - GEOMETRIA DE ALINHAMENTO 

3.2.4.1 – CAMBER 

A primeira e mais conhecida relação de geometria de alinhamento é chamada de camber, ou 

popularmente conhecida por cambagem. O ângulo de camber é a inclinação da roda em relação à 

vertical numa vista frontal do veículo. Quando a parte superior da roda está inclinada na direção do 

 

Figura 3. 11 - Ângulo anti-squat (Milliken & Milliken, 1995) 
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chassi o ângulo é convencionado como negativo. De maneira contrária, quando a parte superior da 

roda está inclinada na direção oposta, o ângulo é positivo (Fig. 3.12)  

 
 

Figura 3. 12 – Ângulo de Camber [11] 

 

Esse ângulo é responsável por vários itens relacionados ao desempenho dinâmico do veículo, 

principalmente em curvas. Ele é responsável pelo maior contato do pneu com o solo em curvas, 

causando assim um pior controle do carro em trechos retilíneos caso o ângulo seja grande. Quando o 

carro entra em uma curva, ocorre a rolagem do chassi e isso faz com que as rodas inclinem na direção 

oposta à curva, causando assim um aumento do camber positivo e reduz o contato do pneu, deixando o 

carro menos estável (Alexander, 1991).  

A melhor maneira de saber se a inclinação imposta está adequada é medindo a temperatura do 

pneu após algumas voltas. Essa medida é feita tomando-se a temperatura em uma linha ao longo da 

face de contato do pneu. Em geral, o máximo utilizado é por volta de 3 graus de inclinação negativa. 

Caso seja maior, irá causar perda na dirigibilidade, pois o pneu levará mais tempo para tornar-se plano 

na pista após entrar em uma curva (Alexander, 1991).  

 

3.2.4.2 - ÂNGULO DO PINO MESTRE OU ÂNGULO KINGPIN 

Esse ângulo é medido pela inclinação da linha que liga os pontos externos dos braços de 

suspensão superior e inferior, ou seja, o eixo de rotação de direção da roda na vista frontal. Pode-se 

ainda compreendê-lo como sendo o ângulo formado pelo eixo de esterçamento da roda ao cortar a 

pista e uma linha vertical à pista passando por esta intersecção (Fig. 3.14). Trata-se do eixo principal 

de rotação da roda no sistema de direção do veículo, ou seja, quando o volante é girado a roda irá 

mudar de direção girando sobre esse eixo Fig. (3.13) e Fig. (3.14).  
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Figura 3. 13 - Eixo kingpin e localização da barra de direção [12] 

 

 

 

Quando se utiliza tração traseira, como nos casos dos carros de corrida, é comum utilizar 

ângulos de kingpin menores que 8. Esse ângulo afeta o desempenho do carro quando as rodas estão 

esterçadas, deve-se deixar bem claro que, quanto maior esse ângulo, mais o carro é levantado quando 

esterçado (Milliken & Milliken, 1995).  

  

 

 

 

Figura 3. 14 – Ângulo kingpin, kingpin offset e camber – vista frontal. [13] 
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3.2.4.3 - CASTER 

 O caster é a inclinação da linha, medida em relação à vertical, que liga os pontos externos dos 

braços superiores e inferiores da suspensão na vista lateral Fig. (3.14). Outra forma de definir o caster 

é como sendo a inclinação do kingpin com a vertical na vista lateral. O caster é dito positivo se sua 

inclinação for para a parte traseira do carro e, ao contrário, é dito negativo se sua inclinação for para a 

parte dianteira. 

 O caster positivo tende a manter a roda em uma linha reta enquanto o veículo se desloca para 

frente, ou seja, melhora sua estabilidade em retas. Isso ocorre devido à inclinação do seu eixo de 

esterçamento e ao caster, pois ao prolongar essa inclinação até o solo tem-se uma distância em relação 

ao centro de contato do pneu, chamada de trilha Fig. (3.14). Quanto maior a trilha causada pelo caster, 

maior é o braço de momento em relação ao eixo de esterçamento. Devido a isso o caster possui uma 

relação direta com o auto-alinhamento do pneu e, consequentemente, quanto maior for o ângulo de 

caster, maior é a força necessária para se fazer uma curva (Alexander, 1991). 

 

 

Figura 3. 15 - Caster e a trilha devido à sua inclinação 
 

 

3.3 - PROJETO DA GEOMETRIA BÁSICA DA SUSPENSÃO  

 A proposição inicial do projeto de suspensão baseou-se, principalmente, em (Milliken & 

Milliken, 1995), em que a metodologia que será apresentada é uma interpretação da existente nessa 

referência. Isso foi feito para tornar o projeto mais intuitivo, para que o leitor, ao se basear na 

metodologia desse texto possa, de maneira iterativa, compreender melhor os efeitos de cada parâmetro 

e suas influências no comportamento do veículo. O novo projeto de chassi do veículo, para a etapa de 

2011, também é um fator limitante, visto que há várias restrições quanto ao tamanho e disposição 

específica de algumas barras estruturais do chassi conforme estabelecido em regulamento [14]. 
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 A seguir é apresentado um fluxograma desenvolvido para esse trabalho que mostra, de 

maneira geral, como se obter a geometria básica de uma suspensão independente do tipo double A-

arm, Fig (3.16).  

 

Figura 3. 16 – Metodologia do projeto de suspensão adotada no trabalho 

 

 Como já citado na seção 3.2.3.1, há duas maneiras de se iniciar o projeto da suspensão 

considerando a vista lateral, pelo valor do ângulo de anti-dive ou pelas localizações dos pontos de 

ancoragem da suspensão. O mesmo pode ser afirmado considerando a vista frontal, em que pode 

iniciar o projeto pelos pontos de fixação ou pelo CI frontal e seus derivados. Considerando a vista 

frontal, primeiramente parte-se da altura do centro de rolagem e do ângulo de camber desejados, com 

isso, obtém-se o centro instantâneo e assim os pontos de ancoragem no chassi (Milliken & Milliken, 

1995). A segunda maneira, a qual foi utilizada nesse trabalho é uma interpretação da metodologia 

sugerida em (Milliken & Milliken, 1995), será detalhada nos tópicos seguintes e terá como base o 

processo iterativo mostrado nas Fig. (3.17) e (3.19). Os critérios de partida e de decisão de cada tópico 

serão também apresentados a seguir.  

 

 

3.3.1 – PROJETO DA VISTA FRONTAL 

 O projeto da vista frontal adotada nesse trabalho foi baseada na metodologia apresentada na 

Fig. (3.16), onde cada uma das etapas e dos critérios encontram-se detalhados nessa seção. 
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Figura 3. 17 – Diagrama de blocos para projeto geometria da vista frontal 

 

1. Ângulo kingpin 

O valor do ângulo de kingpin deve ser definido no começo do projeto da vista frontal, pois esse 

valor determina o eixo de rotação da direção do carro, ou seja, os dois pontos de fixação da manga de 

eixo. Como dito previamente, esse valor deve ser abaixo de 8 para veículos com tração traseira. 

2. Pontos de ancoragem e pontos da manga de eixo 

Partindo das dimensões do chassi Fig. (3.18), estimam-se os pontos iniciais de ancoragem da 

suspensão dianteira. Essa etapa é feita colocando-se os braços de maneira que não fiquem paralelos, 

pois o CI é derivado da intersecção do prolongamento dessas duas linhas, que conectam os pontos 1 ao 

3 e 4 ao 6 Fig. (3.18), como já dito anteriormente. Deve-se observar também, que o carro deve ter uma 

altura mínima em relação ao solo estabelecido pelo regulamento da competição [14] em 50,4mm (2 
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pol.). Para os pontos da manga de eixo foram levadas em consideração a angulação do kingpin e as 

dimensões da roda (Roda 13”, diâmetro interno 300mm).  

 

Figura 3. 18 – Localização dos pontos de ancoragem da suspensão na vista frontal. 

 

3. Centro Instantâneo 

Nessa etapa é definida a intersecção dos links a fim de determinar o CI com base nos pontos de 

fixação dos braços da suspensão Fig. (3.5). 

4. Altura do CI 

A definição da altura do CI é feita com base no scrub, pois de acordo com essa altura poderá haver 

mais ou menos scrub das rodas dianteiras. É um critério de difícil definição, pois qualquer variação 

mínima na locação dos pontos da suspensão pode haver uma grande diferença na altura do CI. Com 

isso, foi estabelecido para esse projeto o intervalo de 40 mm abaixo do solo a 80 mm acima do solo.  

Esses valores foram obtidos a partir da interpretação do que seria um valor desejável para a altura 

do CI. Cabe salientar que esse parâmetro pode influenciar positivamente, melhorando a performance 

do veículo em alguns aspectos, mas pode vir a prejudicar outros. Por exemplo, pode ser desejável um 

centro de rolagem mais alto próximo do centro de gravidade (CG) do veículo, reduzindo o momento 

de rolagem, mas ao fazer isso, aumenta-se o valor do scrub, que prejudica muito a dirigibilidade do 

veículo em retas.  

5. Altura do centro de rolagem 

A altura do centro de rolagem Fig. (3.7) resulta da definição da altura do CI frontal. Os efeitos 

resultantes da altura do centro de rolagem estão relacionados com a distância deste ao centro de 

gravidade do veículo. Dessa maneira, deve-se tentar mantê-lo o mais próximo possível do CG. Como 

o CG do carro foi estimado e, não precisamente calculado, não há precisão quanto à localização desse 

termo. Assim, o compromisso dessa decisão é deixar o centro de rolagem com a distância em relação 

ao solo limitada em 35mm, devido à escolha de deixar o CI mais baixo possível. 
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Com essa altura o carro rolará mais nas curvas e tenderá a ter o comportamento descrito na Tab. 

(3.1) e Tab.(3.2). Essa tabela também mostra o comportamento do carro com o centro de rolagem mais 

distante do solo. 

 

 

Tabela 3. 1 - Efeitos da altura do centro de rolagem frontal [15] 

 

Tabela 3. 2 – Efeitos da altura do centro de rolagem traseiro [7] 

CENTRO DE 

ROLAGEM TRASEIRO 
EFEITOS 

Baixo 

Maior aderência em aceleração 

Maior transferência de peso na traseira 

Menor grip em pouca frenagem 

Usado para o controle da força de rolagem na entrada das curvas 

(aumenta o grip traseiro) 

Usado em condições de baixa aderência 

Alto 

Menos aderência com aceleração 

Carro mais difícil de pilotar 

Usado em condições com alto grip para evitar força de rolagem 

Usado em pistas com rápidas mudanças de direção 

 

6. FVSA (Front View Swing Arm) 

O comprimento do FVSA Fig. (3.8) influencia o quanto de camber se ganha no movimento da 

suspensão. Quanto maior seu comprimento, menor o ganho de camber e vice-versa. Dessa maneira, 

estabeleceu-se o valor mínimo para o comprimento do FVSA em 2000 mm a partir do centro do carro, 

dessa maneira os braços da suspensão não ficam tão inclinados e o consegue-se uma baixa taxa de 

variação de camber. 

 

 

 

CENTRO DE 

ROLAGEM FRONTAL 
EFEITOS 

Baixo 

Mais aderência em aceleração 

Resposta mais lenta 

Melhor em pistas planas com alto grip e curvas de alta velocidade 

Maior transferência de peso para a frente 

Alto  

Menos aderência com aceleração 

Resposta mais rápida 

Menor transferência de peso para frente 

Usado em condições com alto grip para evitar força de rolagem 

Usado em pistas com rápidas mudanças de direção 
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3.3.2 – PROJETO DA VISTA LATERAL 

O projeto da vista lateral adotada nesse trabalho foi baseada na metodologia apresentada na Fig. 

(3.16). 

 

Figura 3. 18 – Diagrama de blocos para o projeto da geometria da vista lateral 

 

1. Pontos de fixação do chassi 

Para a geometria lateral o projeto inicia-se com a localização dos pontos de fixação da suspensão 

no chassi. Esses pontos vão determinar todos os outros parâmetros necessários, para isso devem ter 

uma inclinação mínima para que se possa gerar o CI lateral e deve-se analisar a estrutura do chassi 

para a possível ancoragem. Os pontos 2 e 5 mostrados na Fig. (3.19) devem ter a coordenada Z 

inferior às coordenadas dos pontos 1 e 4 para que se possa gerar o CI para dentro do carro.  
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Figura 3. 19 - Pontos de fixação da suspensão na vista lateral 

 

2. Centro Instantâneo dianteiro e Centro Instantâneo traseiro 

Os CI são obtidos da mesma maneira, tanto para a dianteira quanto para a traseira. Deve-se fazer 

linhas que liguem os pontos 1 ao 2 e 4 ao 5 e o prolongamento dessas linhas gerarão o CI (Milliken & 

Milliken, 1995). 

3. Altura do Centro Instantâneo 

O CI deve ter altura suficiente para não ficar próximo ao solo, geralmente ele é encontrado pouco 

abaixo ou acima do centro da roda. Dessa maneira, estabeleceu-se como critério uma altura do CI de, 

no mínimo, 220mm. 

4. SVSA (Side View Swing Arm) 

O SVSA é obtido pela projeção do CI no solo. A distância dessa projeção ao centro da roda é o 

comprimento do svsa. Esse comprimento será utilizado para o cálculo dos ângulos “anti”. 

5. Ângulos Anti-dive, Anti-lift e Anti-squat 

Os ângulos são calculados segundo as Fig. (3.10) e Fig. (3.11).  

6. Efeitos Anti-dive, Anti-lift e Anti-squat 

Esses efeitos são calculados segundo as Eq. (3.2), Eq. (3.3) e Eq. (3.4). Os valores de decisão 

desses parâmetros estão entre 40 e 60%, pois não sobrecarregam os braços da suspensão e faz com que 

esses efeitos sejam reagidos pelas molas do sistema.  

 

                                        
 

 
  Eq. 3.2 

                                       
 

 
  Eq. 3.3 

           
    

 
 

 
 

     Eq. 3.4 

onde, h é altura do CI lateral e l é a distância entre eixos. 
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 O projeto inicial da suspensão, descrito neste capítulo, será modelado e simulado no MSC 

ADAMS. No próximo capítulo, serão apresentados os resultados das etapas do projeto, bem como 

todos os parâmetros e dados necessários para construção da geometria nos softwares citados. 
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4 – MODELAGEM DA SUSPENSÃO 
 

Seguindo a metodologia e os critérios apresentados 

no Capítulo 3, obteve-se o modelo de suspensão para 

o veículo de competição da Equipe Apuama Racing. 

Todas as etapas do processo de projeto da suspensão 

estão descritas nesse capítulo. 

 

 

4.1 – REQUISITOS DE PROJETO 

 Os requisitos de projeto da suspensão do Fórmula SAE são baseados no regulamento da 

competição [16] e são os seguintes: 

 O veículo deve ter o cockipt aberto e ser do tipo open-wheeled, ou seja, sem para-lamas;  

 A distância mínima entre eixos deve ser de 1525mm, com a largura dos eixos não inferior a 

75% do maior eixo; 

 O projeto deve ser feito de tal modo que nenhuma parte além dos pneus esteja em contato com 

o solo; 

 As rodas devem ter no mínimo oito polegadas de diâmetro (203,2mm); 

 A suspensão deve ter o curso mínimo de duas polegadas (50,4mm), uma polegada em bump e 

uma polegada em rebound; 

 O tamanho e os tipos de pneu são liberados; 

 O sistema de direção deve afetar pelo menos duas rodas; 

4.2 – SUSPENSÃO DIANTEIRA 

4.2.1 – VISTA FRONTAL 

 Para o projeto da suspensão dianteira do carro de competição da Apuama Racing, tomaram-se 

como base as dimensões do chassi conforme mostrado na Fig. (4.1) e Fig (4.2). As coordenadas dos 

pontos da Fig. (4.1) estão descritas na Tab. (4.1). Essas dimensões obedecem ao critério inicial em que 

o ângulo de kingpin deve ser menor que 8 (Milliken e Milliken, 1995). De acordo com essas 

coordenadas Tab. (4.1) esse valor é de 6,48. Esse valor é calculado de acordo com a seção 3.2.4.2 por 

meio da medição direta do desenho técnico da suspensão, assim como todas as dimensões que foram 

obtidas para esse trabalho. Todas as unidades das dimensões encontradas nas figuras, bem como as das 

tabelas, são dadas em milímetros. 
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Figura 4. 1 – Chassi do projeto 2011 da Equipe Apuama 

 

 

 

Figura 4. 2 – Dimensões do chassi e pontos de localização da suspensão 

Tabela 4. 1 - Coordenadas iniciais dos pontos da suspensão dianteira 

Ponto X (mm) Y (mm) Z (mm) 

1 0,00 190,00 130,00 

3 150,00 580,00 140,00 

4 0,00 190,00 320,00 

6 175,00 555,00 360,00 

 

 O CI e a altura do centro de rolagem do projeto são mostrados na Fig. (4.3). O centro de 

rolagem possui altura igual a 15,84 mm, em relação ao solo e o FVSA possui o comprimento de 

2220,6 mm. 
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 Optou-se por um critério de centro de rolagem baixo a fim de se obter as características 

apresentadas na Tab. (3.1). No entanto, esse parâmetro pode ser alterado futuramente caso se deseje 

um carro com outras características. A altura do centro de rolagem foi obtida pela medição direta do 

desenho da suspensão na vista frontal como mostrado na Fig. (4.3) e na seção 3.2.2.1. 

 
Figura 4. 3 – Altura do centro de rolagem, comprimento do FVSA e altura do CI. 

 

4.2.2 – VISTA LATERAL 

 Para o projeto da vista lateral além das dimensões do chassi, deve-se ter em mãos os dados da 

altura do centro de gravidade (CG), a distância entre eixos e o percentual de frenagem dianteiro. A 

partir disso, estimam-se os pontos de fixação da suspensão no chassi. Dessa maneira, apresentam-se os 

dados de partida do projeto na Tab. (4.2). O CG do carro completo foi estimado com base nos CG’s do 

chassi, do piloto e do motor.  

Tabela 4. 2 - Dados gerais para construção da vista lateral 

 Item Valor 

Geral 

Centro de gravidade 330mm 

Distância entre eixos 1700mm 

%Frenagem Dianteira 60% 

A Figura (3.19) descreve os pontos da suspensão cujas localizações são apresentadas na Tab. 

(4.3). Esses pontos são utilizados para determinação da geometria segundo a vista lateral e são obtidos 

pelo processo de iteração apresentado no Capítulo 3.  

Tabela 4. 3 - - Coordenadas dos pontos de fixação da suspensão dianteira 

Ponto X (mm) Y (mm) Z (mm) 

1 0,00 190,00 130,00 

2 330,00 190,00 150,00 

4 0,00 190,00 360,00 

5 330,00 310,00 300,00 

A Figura (4.4) exibe os valores das dimensões da vista lateral, nela podem-se encontrar os 

valores do comprimento do SVSA, a altura do CI lateral e o ângulo F. 
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Figura 4. 4 – Dados geometria lateral 

 

Dessa maneira, conclui-se o projeto da suspensão dianteira. A Tabela (4.4) mostra um resumo 

de todos os pontos de fixação e todos os parâmetros da suspensão dianteira. Para as coordenadas dos 

pontos 3 e 6 Fig. (4.2) também foi levado em consideração o valor do ângulo de caster. 

Tabela 4. 4 – Dados gerais suspensão dianteira 

Dianteira 
Ponto X (mm) Y (mm) Z (mm) 

1 0 190 130 

2 330 190 150 

3 150 580 140 

4 0 190 360 

5 330 310 300 

6 163 555 360 

Altura CI frontal 68,36mm 

Altura Centro de Rolagem 15,84mm 

Comprimento FVSA frontal 2220,6mm 

Ângulo kingpin 6,48 

Ângulo caster 5,94 2 

Altura CI lateral 225,0mm 

Comprimento SVSA lateral 1402,5mm 

Ângulo F 9,11 3 

Anti-dive 49,56% 4 

                                                 
1
 O ângulo kingpin é definido na seção 3.2.4.2 e 4.2.1 

2
 O ângulo de caster é definido na seção 3.2.4.3  

3
 Ângulo F é definido na seção 3.2.3.1 

4
 Anti-dive é definido na seção 3.2.3.1 e calculado segundo a Eq.3.2 da seção 3.3.2 
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4.3 – SUSPENSÃO TRASEIRA 

4.3.1 – VISTA FRONTAL 

Para o projeto da suspensão traseira, foram utilizados os mesmos critérios da suspensão 

dianteira. A nomenclatura dos pontos obedece aos mesmos critérios da Fig. (4.2).  

A Figura (4.5) mostra as dimensões da altura do CI frontal, do comprimento do SVSA e a 

altura do centro de rolagem.  

 

Figura 4. 5 – Altura do centro de rolagem, comprimento do SVSA e altura do CI frontal da suspensão 

traseira 

 

4.3.2 – VISTA LATERAL 

A Figura (4.6) mostra as dimensões do comprimento do SVSA lateral, da altura do CI lateral e 

o ângulo R utilizado para o cálculo do anti-squat (Eq. 3.3). 

 

A Tabela (4.5) exibe a localizações dos pontos da suspensão traseira e exibe o resumo dos 

dados da geometria da suspensão traseira. 

 

 

Figura 4. 6 – Dados geometria lateral traseira 
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Tabela 4. 5 - Dados gerais suspensão traseira 

Traseira 

Ponto X (mm) Y (mm) Z (mm) 

1 1610 173 130 

2 2010 155 115 

3 1860 600 145 

4 1610 203 308 

5 2010 155 330 

6 1885 575 352 

Altura CI frontal 56,3mm 

Altura Centro de Rolagem 17,75mm 

Comprimento SVSA frontal 1925,0mm 

Ângulo kingpin 6,89 

Altura CI lateral 234,44mm 

Comprimento SVSA lateral 1766,1mm 

Anti-squat 64,66% 6 

 

4.4 – PROJETO DA GEOMETRIA DE SUSPENSÃO NO SOFTWARE MSC 
ADAMS/CAR 

 O MSC ADAMS/Car é o software de dinâmica multicorpos e de análise de movimentos mais 

utilizado no mundo. Ele ajuda os engenheiros a estudar a dinâmica de peças móveis, como as cargas e 

forças estão distribuídas por todos os sistemas mecânicos e, ajuda também, na otimização de 

desempenho dos seus produtos [17]. Dessa maneira, o modelo da suspensão do projeto foi construído 

nesse programa como forma de estudo do seu comportamento. 

 Em geral, os softwares multicorpos, assim como o ADAMS/Car, não trabalham, 

necessariamente, com a interface gráfica permitindo a visualização tal como ele é na realidade. O que 

realmente interessa ao programa são as propriedades da peça: massa e inércia. Assim, para a 

construção de um modelo é comum se trabalhar em paralelo com um software CAD para facilitar o 

desenho e a obtenção das propriedades de cada peça, tendo em vista que a construção de peças no 

ADAMS/Car não é tão simples e não possui a quantidade de ferramentas de desenho que um software 

de CAD possui.  

 A seguir serão demonstrados os principais conceitos necessários para a construção de modelo 

no ADAMS/Car. 

 

4.4.1 – CONCEITOS BÁSICOS DO SOFTWARE MSC ADAMS/CAR 

 A construção de qualquer modelo (suspensão, direção, etc.) no ADAMS/Car é iniciada no 

modo Template Builder. Primeiramente, deve-se criar o novo template em File>New, pois é nesse 

                                                 
5
 O ângulo kingpin é definido na seção 3.2.4.2 e 4.2.1 

6
 Anti-squat é definido na seção 3.2.3.1 e calculado segundo a Eq.3.4 da seção 3.3.2 



   31 

momento que se define o subsistema (suspensão, direção, sistema de freio, etc.) na opção Major Role. 

A definição dessa etapa é crucial, pois esse modelo só poderá ser utilizado para tal finalidade. Se 

houver erro nessa criação não será possível fazer o assembly do conjunto para as simulações. 

O menu Build na barra de ferramentas Fig. (4.7) é o principal acesso às ferramentas 

necessárias nesse processo de criação. 

 

Figura 4. 7 - Menu Build 

 

 A construção se inicia com a criação dos Hardpoints, que são todos os pontos de fixação da 

suspensão. Para criar um ponto é necessário dar algumas informações como, nome do ponto e 

coordenadas. As coordenadas devem ser separadas por vírgula, tendo em vista que as casas decimais 

são separadas por pontos. É comum dar como entrada os dados do lado esquerdo da suspensão, ou 

seja, os valores das coordenadas como X, -Y, Z.  

Na área de trabalho os hardpoints aparecem na cor verde, com a seguinte nomenclatura: 

hpl_name, onde hp significa hardpoint, l indica o lado esquerdo (left) e se for do lado direito será r 

(hpr - right) e name indica o nome dado ao ponto. Todos os itens que serão criados aparecem na tela 

de trabalho com a nomenclatura similar à dos hardpoints. É uma maneira simples de se diferenciar 

cada tipo de item criado. 

A criação das peças, ou partes (chamadas pelo programa de General Part) do sistema é feita 

no menu Build>Parts>New ou Wizard Fig. (4.8). O que diferencia uma opção da outra é que ao usar o 

New cria-se a peça dando todas as informações de localização, orientação, massa, inércia e material, 

mas não é criada a geometria da peça Fig. (4.9 - a). Para criar a geometria da parte é necessário ir ao 

menu Build>Geometry onde há opção de criar vários tipos de geometria como barras, cilindros e 

esferas. Já na opção Wizard a criação da peça é feita com a criação da geometria e as propriedades de 

massa e inércia são dependentes da geometria criada Fig. (4.9 - b). Caso seja necessária a adição de 
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uma nova geometria à peça criada, tem-se a opção de criá-la separadamente e pode-se adicionar ou 

não sua massa e inércia à parte anteriormente criada.  

 

Figura 4. 8 – Menu para criação de partes 

 

 

 

a) b) 

Figura 4. 9 – Imagem da janela de criação de partes: a) Sem criação de geometria; b) Com criação de 

geometria 
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O sistema de amortecimento da suspensão, ou seja, as molas e amortecedores são forças 

atuantes e para sua criação no programa é necessário ir ao menu Build>Forces. Nessa opção, para 

ambos, são utilizados arquivos da base de dados que possuem as dados característicos de cada 

componente Fig. (4.10). Esses dados estão no formato comprimento e força para molas; velocidade e 

força para amortecedores. Há a possibilidade tanto de edição quanto de criação de curvas, para isso é 

só acessar o menu Tools>Curve Manager ou ainda clicando no botão indicado na Fig. 4.10. Nessa 

janela, Fig. (4.11), é possível ver a curva da mola e ajustá-la de acordo com os parâmetros de cada 

projeto, obtidos via dados do fabricante ou mediante ensaios experimentais. 

 

Figura 4. 10 – Janela de criação de molas. No detalhe em vermelho, o local de edição do arquivo da mola 

 

 

Figura 4. 11 - Janela de edição e criação de curvas de rigidez 

 

Como todo mecanismo deve ter movimentos relativos, são necessárias juntas ou conexões 

para que cada parte do sistema possa se movimentar. Dessa maneira, o ADAMS/Car disponibiliza 

vários tipos de conexões com características diferentes para cada tipo de função desejada no menu 

Build>Attachments>Joints. Como exemplo, pode-se citar o movimento do braço ou bandeja inferior 

da suspensão em relação ao chassi. Nesse caso, utiliza-se uma junta do tipo de revolução (revolute) 
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que é representada graficamente como uma dobradiça, Fig. (4.12). Esta junta possui 1 grau de 

liberdade de rotação em torno do eixo selecionado pelo usuário.  

Outros tipos de junta que se pode citar são a esférica, translacional e cilíndrica. Para cada 

fixação deve ser avaliado o tipo de junta adequado para que o sistema funcione de maneira correta, e 

não haja redundância de graus de liberdade. As boas práticas de modelagem recomendam que sejam 

elaboradas tabelas descrevendo o tipo de junta, seu respectivo nome e as partes conectadas. Na janela 

de criação das juntas deve-se atentar para marcar a caixa Kinematic mode do item Active, como 

mostrado na Fig. (4.13). 

 

Figura 4. 12 – Imagem da junta de revolução (tipo dobradiça) e buchas de fixação nas extremidades da 

bandeja (com detalhe em vermelho) 

 

Figura 4. 13 – Janela de criação/modificação de juntas, no detalhe a opção de ativação da junta 
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Com relação à fixação do subsistema ao chassi devem-se utilizar dois recursos: o primeiro é o 

mount que atua como um chassi ou qualquer outra parte que não está presente no sistema em 

construção, já que no sistema de suspensão não se constrói o chassi. A função do mount é ser 

substituído por um sistema já existente no momento da montagem de um sistema com outro, um 

mount parts pode fazer o papel do chassi, da roda, carenagem, direção, etc. O segundo modo de 

fixação é o que o programa nomeia de buchas (bushing).  

Para que o software faça a fixação, por exemplo, da bandeja da suspensão com o chassi, cria-

se primeiramente um mount no menu Build>Parts>Mount. Após criado o mount é necessário criar as 

buchas de fixação para os pontos que estão conectados ao chassi. A Figura (4.12) mostra no detalhe 

duas buchas de fixação das extremidades de um braço de suspensão do tipo Duplo A. Similarmente às 

juntas, para as buchas deve-se sempre deixar a caixa Kinematic mode do item Inactive marcada, em 

uma janela parecida à mostrada na Fig. (4.13). 

Outro conceito muito importante e que é fundamental para o sucesso da construção de um 

modelo chama-se Communicators. Os comunicadores se dividem em duas categorias: de entrada 

(input) e de saída (output). Eles são responsáveis pela comunicação do sistema criado com os outros 

sistemas que serão unidos para formar um conjunto que será simulado e analisado. Para isso, o 

programa oferece uma ferramenta de informação e teste sobre os comunicadores já existentes no seu 

modelo e no modelo que será feita a conexão para posterior simulação.  

Um tutorial detalhado de tudo que foi dito nessa seção encontra-se disponível para download 

na página do desenvolvedor do software MSC-ADAMS/Car em [18]. 

 

4.5 – MODELO CONSTRUÍDO NO ADAMS/CAR 

Os modelos das suspensões dianteira e traseira que serão apresentados a seguir foram 

desenvolvidos pelo fabricante do software e adaptado para atender aos requisitos desse projeto.  

 

4.5.1 – SUSPENSÃO DIANTEIRA 

 A seguir serão apresentadas as imagens que resultaram da adapatação da suspensão dianteira. 

No próximo capítulo serão apresentados os resultados de simulações preliminares do modelo 

computacional adaptado e desenvolvido nos capítulos anteriores.  

Dessa maneira, será possível uma primeira análise da suspensão do projeto. As Figuras (4.14), 

(4.15) e (4.16) mostram, respectivamente, o modelo resultante da adaptação no ADAMS/Car em vista 

frontal, lateral e na perspectiva. 
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Figura 4. 14 - Suspensão dianteira vista frontal 

 

Figura 4. 15 - Suspensão dianteira vista lateral 

 

Figura 4. 16 - Suspensão dianteira vista em perspectiva 
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4.5.2 – SUSPENSÃO TRASEIRA 

 Assim como na suspensão dianteira, a traseira também foi adaptada de um modelo pré-

existente desenvolvido pela fabricante. As Figuras (4.17), (4.18) e (4.19) mostram, respectivamente, o 

modelo construído na vista frontal, lateral e perspectiva. 

 

Figura 4. 17 - Suspensão traseira vista frontal 

 

Figura 4. 18 - Suspensão traseira vista lateral 

 

Figura 4. 19 - Suspensão traseira vista em perspectiva 
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5 – ANÁLISE DAS SUSPENSÕES 
 

Esse capítulo apresenta as simulações estáticas dos 

sistemas de suspensão projetados e a análise dos 

parâmetros envolvidos em função da variação de 

alguns critérios. Será apresentado, também, um breve 

tutorial para realização das simulações. 

 

 

5.1 – DESCRIÇÃO E BREVE TUTORIAL DE SIMULAÇÕES 

 Neste capítulo serão apresentadas as simulações que foram realizadas a partir das suspensões 

dianteira e traseira adaptadas, mostradas no capítulo anterior. Para tanto, serão  feitas análises de 

alguns parâmetros disponíveis no módulo ADAMS/Post Processor. O intuito é poder avaliar as 

características geométricas do subsistema. 

 O ADAMS/Car, no ambiente Standard Interface, disponibiliza no menu principal a opção 

simulate. Nela várias opções de simulações são propostas, dentre as quais, aquelas que permitem que 

seja verificado apenas o subsistema de suspensão (ou suspensão mais o sistema de direção), são elas: 

Parallel Wheel-Travel Analysis, Opposite Wheel-Travel Analysis e Single Wheel-Travel Analysis. 

Todas estão agrupadas dentro de uma classe denominada Wheel-travel Analysis. As opções 

disponíveis permitem que o projetista avalie como certas características da suspensão se alteram à 

medida que a mesma se movimenta verticalmente. Em todas elas o projetista estabelece um intervalo 

de Bound e Rebound.  

 Outra possibilidade de análise isolada da suspensão é a Roll & Vertical Force Analysis. Esta 

análise, diferentemente da Opposite Wheel-Travel, permite que as rodas variem sua posição na vertical 

e ocupem uma posição livremente. Nesse trabalho, o enfoque será apenas nas simulações do tipo 

Parallel Wheel-Travel. 

 Na simulação Parallel Wheel-Travel o sistema de suspensão é submetido à excitação de 

ambos os lados, ou seja, é feito com que as duas rodas tenham um mesmo deslocamento vertical que 

deverá ser determinado no momento da configuração da simulação. Com essa simulação é possível 

avaliar características básicas de qualquer sistema de suspensão por meio de gráficos como: variação 

do camber, do caster, do toe (convergência), dentre vários outros tais como, torque de alinhamento e 

scrub radius. O próprio programa disponibiliza uma série de gráficos pré-determinados que são 

comumente utilizados para avaliar qualquer sistema de suspensão. Os gráficos são criados no 

ADAMS/Post Processor e essa opção será detalhada a seguir. 

 Na Suspension Roll and Vertical Force (rolagem da suspensão), a simulação consiste em fazer 

com que as rodas tenham deslocamento vertical oposto, ou seja, enquanto uma roda tem curso 

positivo, a outra possui curso negativo. Dessa maneira, pode-se aproximar este comportamento ao de 
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uma curva. Nessa simulação é possível interpretar alguns comportamentos que não ocorrem na 

simulação Parallel Wheel-Travel, assim, podem-se obter gráficos como: roll steer, que é a mudança 

de direção das rodas durante a rolagem do carro; toe, a mudança da convergência (efeito diferente do 

que ocorre na Parallel Travel).  

 Para que seja possível realizar as simulações no ADAMS/Car, é necessária uma primeira 

preparação do modelo. Quando se termina de criar ou adaptar o modelo, no modo Template Builder 

(Seção 4.4.1), é preciso executar o programa no modo Standard Interface, pressionando a tecla F9 do 

teclado ou reiniciando o software na janela inicial Fig.(5.1).  

 

 

Feito isso, deve-se criar um arquivo do tipo subsistema (subsystem) pelo menu 

File>New>Subsystem. Isso é feito para que o ADAMS/Car identifique a suspensão criada como um 

subsistema e não somente como um projeto isolado de um subsistema. Na janela que será aberta para 

criação do subsistema deverá ser localizado o arquivo (template) criado na seção anterior.  

Para que o programa possa simular a suspensão, é necessário que se faça uma montagem 

(assembly) com outro subsistema que é responsável pela excitação da suspensão. Esse subsistema é o 

Test Rig, que é similar a uma bancada de testes. Isso é feito pelo menu File>New>Suspension 

Assembly. Nesse momento, já é possível realizar as simulações desejadas. Ao fazer a montagem, pode 

ser adicionado o subsistema de direção para as simulações específicas que envolvem a aplicação de 

forças ou deslocamentos decorrentes de sua mudança. Nesse projeto, a suspensão dianteira será 

simulada sem o subsistema de direção. Mas, os mesmos parâmetros que são avaliados com a 

simulação Parallel Wheel Travel também podem ser avaliados para a simulação com o sistema de 

direção. 

 A janela de configuração da análise Parallel Wheel-Travel é aberta pelo menu 

Simulation>Suspension>Parallel Wheel-Travel Fig. (5.2), em que é solicitado o nome da simulação 

(Output prefix), a quantidade de passos da simulação (Steps), o quanto a roda será deslocada na 

vertical positiva (Bump) e o quanto será deslocada na vertical negativa (Rebound). Após a inserção de 

todos esses dados é possível realizar a simulação. O mesmo procedimento é feito para os outros tipos 

de simulação, basta acessar o tipo desejado no menu Simulation>Suspension. 

 

Figura 5. 1 - Tela Inicial MSC ADAMS/Car 
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Figura 5. 2 - Menu Simulate e janela de configuração de simulação Parallel Travel 

 

 Para ter acesso aos resultados das simulações, deve-se acessar o Pós-Processador do 

ADAMS/Car (Post Processor) pelo menu Review>Post Processor ou teclando F8. Na janela que é 

aberta é possível obter todos os resultados diretamente em forma de gráficos. Para exibir os gráficos, 

basta acessar o menu Plot>Create Plots e no campo Plot Configuration File deve-se localizar os 

arquivos padrão de análise de suspensão que estão disponíveis no banco de dados do programa. Há 

dois arquivos utilizados para a análise somente das suspensões: o Suspension Parallel Travel e o 

Suspension Short. O primeiro contém todos os gráficos do segundo e mais alguns outros gráficos 

padrões para uma análise mais detalhada. Já o segundo é suficiente para analisar de forma satisfatória 

o comportamento de uma suspensão. Os gráficos que compõem o Suspension Short são os que serão 

utilizados nesse trabalho. 

 Os gráficos obtidos nas simulações serão explicados na próxima seção, para melhor 

compreensão dos resultados. 

5.2 – PARÂMETROS ANALISADOS 

 Todos os gráficos que serão analisados têm como eixo horizontal os valores de posição em 

função do deslocamento vertical da roda (Wheel Travel) e os parâmetros do eixo vertical são os 

listados abaixo. 

5.2.1 – Percentual Anti-dive/Percentual Anti-lift Braking 

 Esses parâmetros são explicados na seção 3.2.3.1. O software calcula o percentual de anti-dive 

na frenagem, como sendo a razão entre a deflexão causada pelas forças de frenagem e torques em 

relação à deflexão causada pela transferência de peso. 

 O anti-dive é o quanto a suspensão dianteira é comprimida por aceleração de frenagem (em 

G’s), somada à transferência de peso do veículo. Já o anti-lift é o quanto a suspensão traseira é 

estendida devido à transferência de peso, somada à frenagem imposta ao sistema. 
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5.2.2 – Ângulo de Camber 

 O ângulo de camber já foi previamente definido na seção 3.2.4.1. O que o programa analisa é 

a variação da inclinação do camber em função do deslocamento da roda na direção vertical. A Figura 

(5.3) exibe a forma de identificação do valor de camber segundo o software utilizado. 

 

 

Figura 5. 3 - Modo de cálculo do parâmetro ângulo de camber pelo ADAMS/Car (Ref.: Help car_analyses 

pag. 12) 

 

5.2.3 – Braço de Momento do Caster ou Trilha Mecânica 

 A trilha mecânica formada pela inclinação do caster já foi anteriormente definida na seção 

3.2.4.3 e na Fig. (3.15). O que o ADAMS/Car faz para calcular esse parâmetro é identificar a 

intersecção do vetor formado pelo kingpin e a pista (altura zero). Depois, o software identifica o vetor 

formado entre a intersecção anteriormente encontrada e o centro de contato do pneu com o solo. Essa 

distância entre esses dois pontos é a trilha mecânica, Fig. (5.4).  

 

 

Figura 5. 4 – Braço de momento do caster (Caster Moment Arm) e Scrub Radius. Car (Ref.: Help 

car_analyses pag. 59). 
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5.2.4 – Roll Camber Coefficient 

 O roll camber coefficient é a razão entre variação do ângulo de camber e o ângulo de rolagem 

do carro, dado um valor de camber estático previamente estabelecido, em relação à linha 

perpendicular ao solo que divide o carro. Valores positivos desse parâmetro indicam que haverá 

aumento no ângulo de camber durante a rolagem do veículo. A definição de rolagem ou Roll do 

veículo está definida na seção 3.2.2.1.  

 

5.2.5 – Roll Steer 

 Esse parâmetro representa a variação do ângulo de direção da roda (em relação ao centro pneu 

na vista superior, esterçamento), dividida pelo ângulo de rolagem, em relação à linha perpendicular ao 

solo que divide o carro. Quando o carro entra em uma curva, ocorre mudança no valor do ângulo de 

esterçamento da direção. Esse parâmetro indica a relação entre esse ângulo e o ângulo de rolagem do 

chassi. Quando esse valor é positivo indica que, com o aumento do ângulo de rolagem, o ângulo de 

esterçamento da roda aumenta e há a tendência de se tornar mais divergente. 

 

5.2.6 – Scrub Radius 

 Esse parâmetro já foi anteriormente definido na seção 3.2.2.3. Outra maneira de se definir esse 

parâmetro é que ele representa a distância entre a intersecção da projeção do kingpin com o solo e o 

centro de contato do pneu, Fig. (5.4). A maneira que o software utiliza para a determinação desse 

parâmetro é semelhante à da trilha mecânica do caster. É identificada a intersecção entre o vetor do 

kingpin e o solo, posteriormente é identificado o vetor que representa a distância entre essa intersecção 

e o centro do contato do pneu com o solo, como mostrado na Fig. (3.14). 

 

5.2.7 – Toe Angle ou Ângulo de Convergência 

 O ângulo de convergência é a abertura horizontal entre duas rodas de um mesmo eixo. Se elas 

se encontram afastadas (parte mais à frente da roda) há divergência (toe-out), caso contrário há 

convergência (toe-in). A Figura (5.4) mostra de maneira clara esse parâmetro. 
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Figura 5. 5 - Definição de sinal do ângulo de convergência [19] 

 

5.3 – RESULTADOS SUSPENSÃO DIANTEIRA 

 Foi realizada uma análise de sensibilidade para avaliar a influência dos principais parâmetros 

de alinhamento de uma suspensão: camber, caster e toe. Ou seja, o que se deseja é alterar os 

parâmetros básicos de modo que um mínimo de alteração nesses parâmetros seja observada nos outros 

parâmetros tais como anti-dive, anti-lift, roll, etc. Em uma suspensão do tipo “Duplo A” não é comum 

ter a possibilidade de se ajustar o caster de maneira simples. Para realizar alteração nesse parâmetro é 

necessária a troca da manga de eixo, algo não viável para ajuste rápido durante uma prova. Mas, 

mesmo com essa dificuldade, é um parâmetro que deve ser avaliado para verificar se a manga de eixo 

adotada resulta em um bom desempenho para o veículo. 

 As variações dos parâmetros foram feitas segundo os critérios abaixo: 

 ΔCamber: Variou-se o camber da suspensão de -5° a 1°. Esses valores foram obtidos de 

experiências práticas, comumente utilizados em carros de corrida da Stock Car e Fórmula 

3 gentilmente cedido pela equipe Amir Nasr Racing (ANR). Os outros parâmetros foram 

mantidos constantes com os valores: caster= 4° e toe= -1°. Para a variação do camber 

basta acessar o menu Adjust>Parameter Varible>Table. Esses valores para caster e toe 

foram selecionados devido ao fato de serem valores próximos aos que são utilizados na 

prática em carros de competição.  

 ΔCaster: Variou-se o caster da suspensão de 4° a -4°. Os valores foram retirados de 

(Staniforth, 2006), onde os valores sugeridos são de 2° a 6°. Os outros parâmetros foram 

mantidos constantes com os valores: camber= -4° e toe= -1°. A variação do caster é feita 

mudando o posicionamento dos pontos de fixação da manga de eixo no template da 

suspensão. 

 ΔToe: Variou-se o toe de -1° a 1°. Valores também obtidos junto à equipe ANR. O 

camber foi mantido em -4° e o caster em 4°. A variação do toe pode ser feita na mesma 

janela aberta para variação de camber pelo menu Adjust>Parameter Varible>Table. 

 Todos os dados foram obtidos para o curso da suspensão de -40 a 40mm. 
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Tabela 5. 1 - Resumo das simulações da suspensão dianteira 

Simulação  Dianteira 

 
Camber Caster Toe 

Dcamber -5 a 1° 4° -1° 

DCaster -4° 4 a -4° -1° 

DToe -4° 4° -1 a 1° 

 

5.3.1 – Avaliação dos resultados 

5.3.1.1 – Anti-dive 

As Fig. (5.5), (5.7) e (5.8) mostram que as variações dos parâmetros analisados não 

influenciam o comportamento do anti-dive. 

 

Figura 5. 6 - Gráfico Anti-Dive - ΔCamber 

 

 

Figura 5. 7 - Gráfico Anti-dive - ΔCaster 

 

90

100

110

120

130

140

150

-40 -20 0 20 40

A
n

ti
-d

iv
e

 [
%

]

Curso da roda [mm]

Anti-dive - ΔCamber

Camber 1°

Camber -1°

Camber -3°

Camber -5°

90

100

110

120

130

140

150

-40 -20 0 20 40

A
n

ti
-d

iv
e

 [
%

]

curso da roda [mm] 

Anti-dive - ΔCaster

Caster 4°

Caster 2°

Caster 0°

Caster -2°

Caster -4°



   45 

 

Figura 5. 8 - Gráfico Anti-dive - ΔToe 

 

Pode-se observar que a Fig. (5.7) apresenta uma ligeira diferença entre as curvas, a variação 

máxima é de, aproximadamente, 7%. Isso se deve ao fato do caster ser estabelecido pelos pontos de 

fixação da suspensão na manga de eixo que, também, contribuem para definição do anti-dive. De 

qualquer maneira, a variação apresentada nas curvas é muito pequena. Portanto, a conclusão que se 

chega é que a alteração/ajustes dos parâmetros de caster, camber e toe não alteraria no anti-dive, ou 

seja, em ações de frenagem. As curvas das Fig. (5.6) e (5.8) estão sobrepostas e não apresentam 

variação entre seus valores. 

5.3.1.2 – Variação do Ângulo de Camber 

As Fig. (5.9), (5.10) e (5.11) apresentam a variação do ângulo de camber em função do curso 

da roda de -40mm a 40mm. 

 

 

Figura 5. 9 - Gráfico Ângulo de Camber - ΔCamber 
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Figura 5. 10 - Gráfico Ângulo de Camber - ΔCaster 

 

 

Figura 5. 11 - Gráfico Ângulo de Camber - ΔToe 

 

Pode-se observar que, independente da configuração inicial escolhida, há uma tendência de se 

ganhar camber positivo quando a suspensão está submetida à rebound (-40 a 0mm), e observa-se o 

contrário quando submetida a bump (0 a 40mm). Não necessariamente, ganhar camber positivo 

significa ter o valor maior que zero, esse termo é utilizado para indicar a tendência do valor de camber 

aumentar.  

Normalmente, a geometria de uma suspensão terá um ângulo de camber estático definido, o 

que se pretende avaliar nesse item é a variação do ângulo de camber, considerando um movimento 

vertical sincronizado das rodas (Parallel Wheel-Travel Analysis). Em geral a trajetória que se descreve 

segue um arco, como pode ser visto na Fig. (3.8). Portanto, as rodas podem passar por valores de 

camber positivo e negativo durante o bump e rebound definido na simulação. 

Verifica-se na Fig. (5.9) que, segundo os valores de variação de camber adotados, partindo-se 

de um camber positivo de +1º, após um bump de 30 mm, é que esse tende a ser ligeiramente negativo. 

Quanto aos outros valores de camber adotados, todos negativos, a tendência durante toda a trajetória 

vertical é que eles permaneçam negativos, contudo entre -40 e 0 mm esses valores se tornam menos 

negativos. 
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O desejável para uma suspensão é que mantenha o camber negativo independente do curso da 

roda, pois ao fazer uma curva a roda externa tem a tendência a ganhar camber positivo e isso é 

prejudicial, pois há perda de tração devido à menor área de contato do pneu com o solo. Ao se 

trabalhar com o camber negativo não há o ganho de camber positivo e, consequentemente, não há 

tanta perda de tração. Isso pode ser visto na Fig. (5.9), em que a utilização de valores de camber 

negativo (entre -5 e -1°, aproximadamente) atende à demanda de projeto. 

Na Fig. (5.9), pode-se observar que as curvas são idênticas, somente foram transladadas de 

acordo com a configuração inicial da suspensão. 

 O efeito que o caster causa no ângulo de camber pode ser visto na Fig. (5.10). Segundo 

(Milliken, 1995), com caster positivo há a tendência de ganho de camber negativo na roda externa à 

curva, ou seja, em bump (0 a 40mm) e perda de camber negativo na roda interna à curva, em rebound 

(-40 a 0mm). 

 Quanto à influência do toe na variação do camber, a Fig. (5.11) mostra que pode ser 

considerada desprezível. 

 

5.3.1.3 – Trilha Mecânica do Caster 

As Fig. (5.12), (5.13) e (5.14) apresentam a variação da trilha mecânica do caster em função 

do curso da roda de -40mm a 40mm 

 

 

Figura 5. 12 - Gráfico Trilha Mecânica do Caster – ΔCamber 
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Figura 5. 13 - Gráfico Trilha Mecânica do Caster - ΔCaster 

 

 

Figura 5. 14 - Gráfico Trilha Mecânica do Caster - ΔToe 

 

 A variação de camber e do toe não tem influência sobre a trilha mecânica do caster como 

pode ser observado nas Fig. (5.12) e Fig (5.14). Esse parâmetro está totalmente relacionado com a 

variação do ângulo de caster devido ao curso da suspensão. Dessa maneira, quanto maior esse valor, 

maior é a força necessária do piloto para girar o volante para fazer uma curva, visto que o torque 

restaurador será maior nessas condições. 

A Fig. (5.13) mostra o efeito da variação do caster sobre a trilha mecânica formada por ele. 

Esse parâmetro é o que sofre influência mais direta pela variação do caster e afeta diretamente o 

comportamento da direção do veículo. Sua influência está intimamente ligada à dirigibilidade do carro 

como dito na seção 3.2.4.3, em geral, pilotos tendem a preferir um carro com a direção mais “pesada”, 

ou seja, com valores de caster mais altos, pois se tem mais controle da direção, gerando maior 

estabilidade em retas. Nessa simulação não foi utilizado o sistema de direção.  

As curvas da Fig. (5.12) estão sobrepostas e não apresentam variação entre seus valores. 

 

-30

-20

-10

0

10

20

30

40

50

-40 -20 0 20 40

Tr
ilh

a 
m

e
câ

n
ic

a 
d

o
 c

as
te

r 
[m

m
]

Curso da roda [mm]

Trilha Mecânica do Caster - ΔCaster

Caster 4°

Caster 2°

Caster 0°

Caster -2°

Caster -4°

10

15

20

25

30

35

40

45

-40 -20 0 20 40Tr
ilh

a 
m

e
câ

n
ic

a 
d

o
 c

as
te

r 
[m

m
]

Curso da roda [mm]

Trilha Mecânica do Caster - ΔToe

Toe -1°

Toe -0,5°

Toe 0°

Toe 0,5°

Toe 1°



   49 

5.3.1.4 – Roll Camber Coefficient 

Os gráficos da Fig. (5.15), (5.16) e (5.17) apresentam os resultados das simulações para o 

parâmetro roll camber coefficient. 

 

 

Figura 5. 15 - Gráfico Roll Camber Coefficient – ΔCamber 

 

 

Figura 5. 16 - Gráfico Roll Camber Coefficient - ΔCaster 

 

 

Figura 5. 17 - Gráfico Roll Camber Coefficient - ΔToe 
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Os gráficos da Fig. (5.15), (5.16) e (5.17) apresentam o roll camber coefficient, quando esse 

parâmetro é positivo indica que há o ganho de camber por grau de rolagem do chassi, ou seja, ao 

realizar uma curva o pneu tende a ganhar camber positivo. Quanto menor esse valor, menor é o ganho 

de camber positivo em relação à rolagem e, consequentemente, melhor é o contato do pneu com o solo 

em curvas. Nota-se que a variação do caster gera uma pequena diferença entre as curvas do coeficiente 

de rolagem em função do curso dos pneus. 

 As curvas da Fig. (5.17) estão sobrepostas e não apresentam variação entre seus valores. 

5.3.1.5 – Roll Steer 

Os gráficos das Fig. (5.18), (5.19) e (5.20) apresentam os gráficos da mudança da direção (roll 

steer) em função do deslocamento (curso) da roda. 

 

 

Figura 5. 18 - Gráfico Roll Steer – ΔCamber 

 

 

Figura 5. 19 - Gráfico Roll Steer - ΔCaster 
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Figura 5. 20 - Gráfico Roll Steer - ΔToe 

 

Os gráficos das Fig. (5.18), (5.19) e (5.20) apresentam os resultados da mudança da direção 

em função do deslocamento (curso) da roda. Pode-se observar que a influência da variação dos 

parâmetros das simulações é muito pequena para o Roll Steer. Mesmo que pequena estas variações 

aparecerem apenas quando se varia o camber e caster. Percebe-se ainda que nas Fig. (5.18) e (5.19), o 

feixe de curvas tem uma variação entre -0,1 e -0,5. Porém, a variação na convergência diminui essa 

taxa de variação do conjunto de curvas. Além disso, há uma tendência a valores negativos, pode-se 

inferir que o aumento do ângulo de rolagem não exige um aumento do ângulo de esterçamento. 

As curvas das Fig. (5.20) estão sobrepostas e não apresentam variação entre seus valores. 

 

5.3.1.6 – Scrub Radius 

Os gráficos das Fig. (5.22), (5.22) e (5.23) mostram a variação do scrub em função do curso 

da roda. 

 

Figura 5. 21 - Gráfico Scrub Radius – ΔCamber 
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Figura 5. 22 - Gráfico Scrub Radius - ΔCaster 

 

 

Figura 5. 23 - Gráfico Scrub Radius - ΔToe 

 

Esse parâmetro está relacionado com a estabilidade do carro em retas. Dessa maneira, quanto 

menor esse parâmetro melhor é a estabilidade, ou seja, menos a roda irá oscilar em torno de uma linha 

reta. A configuração que tem a maior influência, ou seja, a que dá menor estabilidade ao pneu em retas 

é a que tem o valor de camber -5° na Fig. (5.21). Portanto, a melhor configuração seria com o menor 

camber. Isso porque segundo a Fig. (5.21), a -5º mais distante estará o plano central da roda do 

kingpin. Relativamente ao caster, Fig. (5.22), o caster maior trará o kingpin projetado no plano da 

pista para próximo do plano central da roda. Percebe-se, entretanto, que a mudança do caster de -2º 

para -4º implica em uma sensibilidade grande da geometria. 

 

5.3.1.7 – Ângulo de Convergência (Toe Angle) 

Os gráficos da Fig. (5.24), (5.25) e (5.26) apresentam o valor da variação de toe em função do 

curso da roda. 
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Figura 5. 24 - Gráfico Ângulo de Convergência (Toe angle) – ΔCamber 

 

 

Figura 5. 25 - Gráfico Ângulo de Convergência (Toe angle) – ΔCaster 

 

 

Figura 5. 26 - Gráfico Ângulo de Convergência (Toe angle) – ΔToe 

 

 A variação desse parâmetro sob a influência do camber e do caster é bem semelhante e 

mínima em todos os casos. Já na Fig. (5.26) observa-se que o alinhamento estático preparado para o 

carro pode determinar a intensidade do efeito causado na variação do toe com o curso da roda. Em 

geral, carros de corrida tendem a utilizar esse alinhamento ligeiramente divergente, ou seja, negativo. 
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5.4 – RESULTADOS SUSPENSÃO TRASEIRA 

 Assim como na suspensão dianteira, foram avaliados os mesmos parâmetros: camber, caster e 

toe. Entretanto os valores utilizados nessas variações foram diferentes e seguiramn o seguinte padrão: 

 ΔCamber: Variou-se o camber da suspensão de -5° a 1°. Os outros parâmetros foram 

mantidos constantes com os valores: caster= 6° e toe= 0,5°.  

 ΔCaster: Variou-se o caster da suspensão de 6° a 0°. Os outros parâmetros foram mantidos 

constantes com os valores: camber= -3° e toe= 0,5°. 

 ΔToe:Variou-se o toe de -1° a 1°. O camber foi mantido em -3° e o caster em 6°.  

 Todos os dados foram obtidos para o curso da suspensão de -40 a 40mm. 

Tabela 5. 2 - Resumo das simulações da suspensão traseira 

Simulação  Traseira 

 
Camber Caster Toe 

Dcamber -5 a 1° 6° 0,5° 

DCaster -3° 6 a 0° 0,5° 

DToe -3° 6° -1 a 1° 

5.4.1 – Avaliação dos resultados 

5.4.1.1 – Anti-lift 

As Fig. (5.27), (5.28) e (5.29), mostram o comportamento do anti-lift da suspensão traseira. 

 

Figura 5. 27 - Gráfico Anti-lift - ΔCamber 
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Figura 5. 28 - Gráfico Anti-lift - ΔCaster 

 

 

Figura 5. 29 - Gráfico Anti-lift - ΔToe 

 

 Pode-se perceber que a variação dos parâmetros de teste não tem influência sobre o anti-lift, 

exceto na simulação para o valor de 6° do caster na Fig. (5.28). Isso se deve ao fato da localização dos 

pontos de fixação da manga de eixo que proporcionam esse valor de caster, pois são esses pontos de 

fixação os responsáveis pela determinação desse parâmetro, conforme visto na seção 3.2.3. 

As curvas das Fig. (5.27) e (5.29) estão sobrepostas e não apresentam variação entre seus 

valores. 

5.4.1.2 – Ângulo de Camber 

As Fig. (5.30), (5.31) e (5.32) exibem os gráficos do ângulo de camber em função da variação 

dos parâmetros previamente apresentados. 
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Figura 5. 30 - Gráfico Ângulo de Camber - ΔCamber 

 

 

Figura 5. 31 - Gráfico Ângulo de Camber - ΔCaster 

 

 

Figura 5. 32 - Gráfico Ângulo de Camber - ΔToe 

 

 O ângulo de camber está diretamente relacionado com o contato do pneu com a pista durante 

as curvas. Por isso, deve ser mantido negativo para que esse objetivo possa ser alcançado. Os gráficos 

mostram que a variação do camber com o curso da roda não é grande como na suspensão dianteira, 

Fig.(5.8), (5.9) e (5.10). 
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 Como o camber não pode ser precisamente definido estaticamente para o melhor desempenho 

do carro, é preciso a tomada de temperatura dos pneus para defini-lo. A utilização do alinhamento 

estático com menor valor é mais recomendada para início de testes na pista. 

 Valores de pouca inclinação de camber, -1° e 1° da Fig. (5.30), são pouco utilizados em 

competições, esses valores podem ser utilizados em alguns carros de passeio mais esportivos.  

 As curvas das Fig. (5.31) estão sobrepostas e não apresentam variação entre seus valores. 

5.4.1.3 – Trilha Mecânica do Caster 

 As Fig. (5.33), (5.34) e (5.35) apresentam os resultados das simulações para o parâmetro trilha 

mecânica do caster. 

 

 

Figura 5. 33 - Gráfico Trilha Mecânica do Caster - ΔCamber 

 

 

Figura 5. 34 - Gráfico Trilha Mecânica do Caster - ΔCaster 
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Figura 5. 35 - Gráfico Trilha Mecânica do Caster - ΔToe 

 

A trilha mecânica do caster não tem necessidade de ser avaliada para a suspensão traseira. Na 

traseira não há barra de direção e, consequentemente, não há rotação da roda para mudança de direção. 

Esse parâmetro deveria ser avaliado se o sistema em questão fosse Four-Wheel Steering. Nesse 

sistema, as rodas traseiras do carro possuem um sistema de direção, de menor curso que a dianteira, 

que auxiliam durante uma curva. 

As curvas das Fig. (5.33) estão sobrepostas e não apresentam variação entre seus valores. 

 

5.4.1.4 – Roll Camber Coefficient 

 As Fig. (5.36), (5.37) e (5.38) apresentam os resultados das simulações para o parâmetro roll 

camber coefficient. 

 

Figura 5. 36 - Gráfico Roll camber coefficient - ΔCamber 
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Figura 5. 37 - Roll Camber Coefficient - ΔCaster 

 

 

Figura 5. 38 - Gráfico Roll Camber Coefficient - ΔToe 

 

 Percebe-se nas Fig. (5.36), (5.37) e (5.38) que os parâmetros avaliados nas simulações não 

exercem influência sobre o Roll Camber Coefficient. Na Fig. (5.36) há uma pequena diferença entre as 

curvas, porém não é signicativa. Quando esse parâmetro é positivo indica que há o ganho de camber 

por grau de rolagem do chassi, ou seja, ao realizar uma curva, o pneu tende a ganhar camber positivo. 

Quanto menor esse valor, menor é o ganho de camber positivo em relação à rolagem e, 

consequentemente, melhor é o contato do pneu com o solo em curvas. 

5.4.1.5 – Roll Steer 

Os gráficos das Fig. (5.39), (5.40) e (5.41) apresentam os gráficos da mudança da direção em 

função do deslocamento (curso) da roda. 
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Figura 5. 39 - Gráfico Roll steer - ΔCamber 

 

 

Figura 5. 40 - Gráfico Roll Steer - ΔCaster 

 

 

Figura 5. 41 - Gráfico Roll Ster - ΔToe 

 

Percebe-se, independente do parâmetro avaliado, que há a variação de divergente (-40mm) 

para convergente (40mm). Nesse caso, quanto menor a variação do roll steer, melhor para o carro, 

pois não haverá variação da direção da roda com o curso da suspensão.  
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5.4.1.6 – Scrub Radius 

Os gráficos das Fig. (5.42), (5.43) e (5.44) mostram a variação do scrub em função do curso 

da roda. 

 

Figura 5. 42 - Gráfico Scrub Radius - ΔCamber 

 

 

Figura 5. 43 - Gráfico Scrub Radius - ΔCaster 

 

 

Figura 5. 44 - Gráfico Scrub Radius - ΔToe 
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Esse parâmetro está relacionado com a estabilidade do carro em retas. Dessa maneira, quanto 

menor esse parâmetro, melhor é a estabilidade, ou seja, menos a roda irá oscilar em torno de uma linha 

reta. A configuração que tem a maior influência, ou seja, a que dá menor estabilidade ao pneu em 

retas, é a que tem o valor de camber 1° na Fig. (5.42). Na Fig. (5.43) observa-se que há pouca 

influência do caster. E na Fig. (5.44) o valor de toe que dá o menor scrub é com as rodas divergentes 

em 1°. 

 

5.4.1.7 – Ângulo de Convergência (Toe angle) 

Os gráficos da Fig. (5.45), (5.46) e (5.47) apresentam o valor da variação de toe em função do 

curso da roda. 

 

Figura 5. 45 - Gráfico ângulo de convergência - ΔCamber 

 

 

Figura 5. 46 - Gráfico Ângulo de Convergência - ΔCaster 
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Figura 5. 47 - Gráfico Ângulo de convergência - ΔToe 

 

Nas Fig. (5.45) e (5.46), apesar das curvas aparentarem uma grande variação de toe, essa 

mudança é pequena, como se pode observar na escala do gráfico. Mas de qualquer maneira, deve-se 

atentar para escolher a menor variação possível. 

 

5.5 – DISCUSSÕES 

 No projeto de um sistema de suspensão vários fatores influenciam o desempenho do carro, tais 

como altura do centro de rolagem, camber, convergência, etc. Com isso, alguns itens da geometria 

devem ganhar maior atenção para que se possa obter o melhor desempenho do veículo tanto em retas, 

quanto em curvas. Segundo (Smith, 1978), diferentes filosofias de projeto tendem a se equilibrar em 

termos de tempo de volta, o que se ganhar em retas, perde-se nas curvas e vice-versa. 

 Um dos objetivos de uma suspensão é fazer com que o pneu tenha o maior contato possível 

com a pista e, consequentemente, proporcione maior força vertical aos pneus. Uma discussão completa 

sobre características e comportamento dos pneus necessitaria de um capítulo ou um projeto à parte, 

podendo ser encontrado em (Smith, 1978), (Alexander, 1991) e em (Milliken, 1995). Entretanto, nesse 

texto serão dadas algumas informações sobre pneus para o melhor embasamento das escolhas tomadas 

quanto à geometria da suspensão e seu alinhamento.  

 A força vertical em um pneu é proveniente da soma do percentual do peso total do veículo 

sobre aquele pneu e da componente vertical da força aerodinâmica. A transferência de peso devido à 

dinâmica do veículo muda o tempo todo. Essa transferência de peso pode ser longitudinal, devido à 

aceleração ou frenagem e/ou lateral, durante a mudança de direção. O aumento da força vertical provê 

basicamente dois resultados, o primeiro é em relação ao coeficiente de atrito do pneu, que tende a 

diminuir com o aumento da força, Fig.(5.48). O segundo é em relação à força total no pneu, que 

aumenta com o aumento da força vertical e, consequentemente, há o ganho de tração, Fig. (5.49). 
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Figura 5. 48 - Coeficiente de fricção X força vertical – Smith (1978) 

 

 

Figura 5. 49 - Força no pneu (lbs) X força vertical (lbs). Ref.: Smith (1978) 

 

 Dessa maneira, um dos parâmetros de geometria para o melhor contato do pneu é o camber. 

Segundo (Smith, 1978), o camber deve ser escolhido de tal forma a manter a roda da frente, que está 

mais carregada (externa à curva), mais reta possível do que a roda traseira. Quando o carro entra em 

uma curva, a combinação de transferências de peso irá comprimir mais a mola dianteira externa e o 

papel do camber é compensar a rolagem do chassi.  

 De acordo com os resultados obtidos nas simulações desse capítulo para a variação do camber, 

os valores que apresentaram os melhores desempenhos estão entre -3 e -5° de inclinação.  

 Entretanto, o uso de cambagem só é realmente interessante durante a execução de curvas, pois 

a inclinação do pneu em retas, como em provas de aceleração ou frenagem, é prejudicial. A área de 

contato do pneu com o solo, devido à inclinação do camber, é menor do que quando o pneu está com 

camber nulo (0°), totalmente perpendicular. Por isso, nas simulações de veículo completo, que serão 
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apresentadas no Capítulo 6, serão avaliadas as influências do camber nas provas de aceleração, 

frenagem e skid-pad. 

 O slip angle, ou ângulo de escorregamento do pneu é definido como o deslocamento angular 

entre o plano de rotação da roda (direção na qual a roda está apontada) e o caminho de rolamento do 

pneu, ou seja, o percurso que o pneu se desloca no solo, Smith (1978). Segundo Milliken (1995), se o 

pneu é defletido ou inclinado e, depois, rolado na pista, ele se move em uma direção com um ângulo 

relativo à direção que a roda está apontada. A Fig. (5.50) mostra um desenho esquemático do slip. 

 

Figura 5. 50 - Slip Angle e trajetória do pneu – Ref. Smith (1978) 

 

Quanto à convergência ou divergência das rodas (toe), há vários pontos positivos e negativos 

sobre cada um. Para tornar o veículo dinamicamente mais estável, utiliza-se toe-in. Se uma carga é 

transferida lateralmente entre um par de rodas, por uma irregularidade da pista ou uma rajada de vento, 

por exemplo, causará um aumento relativo do ângulo de deslizamento (slip) da roda com maior carga. 

Se as rodas estão divergentes quando isso ocorre, a deformação fará com que o veículo se oriente na 

direção da roda interior, que está apontada para a outra direção. Isso pode ser mais perturbador na 

frente do carro. Na traseira, a descrição usual é “perda de controle”. Por outro lado, se as rodas estão 

convergentes, a roda externa tende para a roda interna, mas a roda está apontada na direção que 

queremos o carro siga e o veículo é auto-corrigido ou dinamicamente estável, (Smith, 1978). 

Ao se utilizar um pouco de divergência entre as rodas, diminui-se o slip angle dos pneus 

dianteiros na entrada em uma curva. Essa escolha reduz o potencial de sub-esterçamento, ou 

understeer. O understeer é a perda de aderência dos pneus dianteiros, ou como se diz comumente 

“perder a frente”. O oversteer, ou sobre-esterçamento, é a perda de aderência dos pneus traseiros. 

Porém, se for utilizado muita divergência o veículo se torna instável em bumps e em frenagens.  
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Na traseira, pode-se utilizar convergência para reduzir o potencial de oversteer durante 

aceleração em curvas, pois com o squat (deflexão da traseira durante aceleração) do veículo tende-se a 

convergir um pouco mais as rodas traseiras, o que as faz apontar mais na direção das curvas, 

melhorando o desempenho em curvas. 

Esse parâmetro pode ser avaliado nos gráficos de roll steer apresentados anteriormente nas 

Fig.(5.18), (5.19) e (5.20) para a dianteira, e (5.39), (5.40) e (5.41) para a traseira. É bastante 

complicado definir um valor para o parâmetro convergência, pois se trata de um ajuste muito fino, em 

que se ficar um pouco além do previsto podem-se ter inúmeras complicações de instabilidade em retas 

e em curvas. Outro fator complicador é a característica do piloto que guiará o veículo, há pilotos que 

preferem, por exemplo, um carro com comportamento mais oversteer do que understeer.  

 O caster é um parâmetro em que sua mudança não é tão simples quanto uma mudança de 

camber ou de toe. Por isso, será utilizado o valor de 4°, pois é o valor que apresenta melhores 

resultados apresentados nas simulações apresentadas nesse capítulo. Como dito anteriormente, sua 

função é promover estabilidade em retas, sensibilidade ao piloto e auto-alinhamento. Não há na 

literatura um valor padrão ou ideal para ele, sabe-se que caster positivo causa, na roda externa à curva, 

um ganho de camber negativo quando a direção é esterçada, mas também causa ganho positivo com a 

rolagem do chassi. Se seu valor for alto (>8 ou 10°), requer do piloto muita força para virar o carro. Se 

for muito baixo (  0°) o carro fica muito sensível e qualquer toque no volante pode fazer o piloto 

perder o controle do carro. Caso eles estejam desiguais, direita e esquerda, o carro tenderá a virar 

sozinho para a direção com maior caster, o que causa, também, instabilidade e esforço do piloto para 

poder segurar o carro na pista. 

A avaliação de qual parâmetro poderá melhor se encaixar ao projeto será apresentada no Cap. 

6, em que será estudado o comportamento dinâmico do veículo completo e uma análise das forças nos 

pneus auxiliará para sua determinação. 
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6 – ANÁLISE DO VEÍCULO 
 

Esse capítulo apresenta as simulações dinâmicas do 

veículo completo em algumas condições encontradas 

na competição da Fórmula SAE. O desempenho das 

suspensões para o veículo em movimento será 

analisado por gráficos. Será apresentado, também, 

um breve tutorial para realização das simulações. 

 

 

6.1 – PREPARAÇÃO E DESCRIÇÃO DAS SIMULAÇÕES PARA VEÍCULO 

COMPLETO 

6.1.1 – Preparação dos subsistemas 

 
 Para simular um veículo completo no módulo ADAMS/Car são necessários alguns dos 

subsistemas básicos para compor o carro, isto significa que nem todas as simulações exigem que todos 

os subsistemas estejam presentes. Nas simulações aqui realizadas, além das suspensões dianteira e 

traseira, são necessários outros subsistemas, que no caso do presente trabalho, foram adaptados ou 

diretamente utilizados dos já existentes na biblioteca do software. Inclusive, a fabricante MSC 

Sotware disponibiliza em seu site arquivos específicos para o Fórmula SAE e o Mini-Baja. Como já 

citado, as suspensões apresentadas configuram adaptações dos modelos disponíveis no site. 

 Os subsistemas necessários para as simulações são os enumerados abaixo: 

 Suspensões dianteira e traseira; 

 Sistema de freios; 

 Sistema de propulsão – motor, caixa de velocidades (marchas); 

 Chassi; 

 Pneus e rodas; 

 Sistema de direção; 

Eles são capazes de garantir o funcionamento básico do veículo proporcionando as ações 

principais como condução, aceleração e frenagem. Conforme citado, dos subsistemas acima alguns 

foram adaptados para atender às necessidades do projeto. Isso foi feito por não se tratar do escopo do 

projeto, além de demandar muito tempo e recursos para a concepção desses componentes.  

Entretanto, as modificações feitas nesses modelos não foram somente para o simples encaixe 

de sistemas, tentou-se aproximar alguns dados condizentes com a realidade do carro Fórmula SAE. 

Por exemplo, os arquivos disponibilizados na base de dados do programa para o subsistema de motor 

apresentam apenas dois tipos de motores, totalmente diferentes dos utilizados na competição. Esses 

dois modelos são um motor V8 de 240HP e um motor V12 de 5 litros e, pelo regulamento da 
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competição, pode-se ter motores de até 600cc, chegando, portanto, a no máximo a 120cv. Entretanto, a 

MSC disponibiliza no seu site um banco de dados que contém os dados de um motor de 600cc 

utilizado na competição. Esse arquivo foi utilizado no subsistema de motor e a sua massa foi estimada 

em 50 kg.  

 O subsistema chassi é equivalente ao utilizado pela equipe. Ele possui 150 kg de massa 

concentrada, que estima todos os componentes embarcados no veículo. Foi adicionada à massa do 

chassi a massa do piloto com valor estimado de 70 kg. Além disso, foram utilizados os momentos de 

inércia do chassi que será utilizado pela equipe. 

 Para o subsistema de roda e pneu, o módulo disponibiliza uma série de arquivos com vários 

modelos de pneus. O modelo utilizado foi o Packeja 2002 (PAC2002) com dimensões 175/70 R13, 

pois segundo a tabela da Figura (6.1) apresentada em um dos arquivos de ajuda do ADAMS/Car, esse 

modelo é o mais abrangente e o mais recomendado para todas as condições de simulação. Além disso, 

é o modelo que mais condiz com a realidade de um pneu. 

 

Figura 6. 1 - Tabela de seleção dos tipos de pneus – Ref. Arquivo de ajuda do ADAMS/Car 

 

 

 Para o sistema de freios não foi feita nenhuma modificação, por não ser necessário. Já no 

sistema de direção foi feita uma única mudança na razão entre o pinhão e a cremalheira para o valor de 

1:16, valor sugerido por (Smith, 1978). 
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6.1.1 – Tutorial das simulações  

 Na interface padrão do ADAMS/Car (Standard Interface), no menu principal na opção 

Simulate, há uma grande quantidade de simulações que se referem ao veículo completo nas mais 

diversas condições. Cada simulação pode ser feita em, no mínimo, duas condições, pistas em duas ou 

três dimensões. As pistas de duas dimensões são planas e pode-se trabalhar com a mudança de direção 

de diversas formas. Já as pistas em três dimensões possuem irregularidades e simulam condições mais 

reais de pistas, por exemplo, existe no banco de dados um arquivo com as características da pista de 

Imola, na Itália. Uma grande vantagem que o programa oferece é a criação de pistas novas ou a edição 

das existentes. 

 Inicia-se uma simulação em pista pela montagem do modelo, ou seja, a criação do Assembly. 

Para isso devem ser criados os subsistemas explicados na seção 6.1.1 e na seção 5.1. Para fazer a 

montagem dos subsistemas, deve-se acessar o menu File>New>Full-Vehicle Asssembly. Isso fará 

abrir uma janela, Fig. (6.2), em que se selecionam os arquivos referentes aos subsistemas que irão 

compor o modelo do veículo completo. Nessa janela, deve-se escolher os subsistemas básicos criados 

e também deve ser dado um nome ao Assembly. Depois de concluída essa etapa, é possível visualizar o 

modelo na área de trabalho do programa, como ilustrado na Fig. (6.3). A partir desse ponto já é 

possível realizar as simulações. O menu suspenso da janela, o Vehicle Test Rig, é um subsistema 

padrão do programa. Sua função é fazer a comunicação entre o modelo e as condições impostas nele. 

 

Figura 6. 2 - Menu e janela de criação da montagem do veículo completo 
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Figura 6. 3 - Imagem do veículo completo 

 

Ao acessar o menu Simulate>Full-vehicle Analysis o usuário pode escolher qual simulação 

pretende utilizar para avaliar seu modelo Fig (6.4).  

 

Figura 6. 4 - Menu de simulações de veículo completo 

 

 Como mostrado na Fig. (6.4), as simulações são divididas em: 

 Open-Loop Steering Events – são simuladas situações de mudanças rápidas de direção, 

como uma mudança de faixa em uma pista ou um desvio rápido de um buraco, por 

exemplo. Nenhuma dessas simulações serão utilizadas nesse projeto, por não estarem 

incluídas nas provas da competição. Nesse item há sete tipos de simulações diferentes: 

Drift, Fish Hook, Impulse Steer, Ramp Steer, Single Lane Change, Step Steer e Swept-Sine 

Steer 

 Cornering Events – nesse grupo de simulações são avaliadas condições de curva, com ou 

sem frenagem. Nessa categoria de simulações encontra-se a simulação de curva com raio 

constante, ou seja, skid-pad. Essa simulação configura uma das provas dinâmicas da 

competição, por isso ela foi selecionada nesse trabalho e será avaliada posteriormente. 
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Nesse item há cinco tipo de simulações: Braking-in-turn, Constant Radius Cornering, 

Cornering w/Steer Release, Lift-off Turn-in e Power-off Cornering. 

 Straight-Line Events – nessa categoria de simulações avaliam-se, basicamente, as 

condições de aceleração e frenagem em linha reta. Essas duas condições também são 

encontradas na competição. Nesse menu há três simulações: Acceleration, Braking e 

Power-off Straight Line. 

 Course Events – nesse menu as simulações utilizam arquivos que contêm os dados de uma 

pista, ou condição de pista. Há dois tipos de simulações: ISO Lane Change e 3D Road. 

 File Driven Events – nessa simulação são selecionados dois arquivos, um que contém o 

tipo de pista, e o outro, informações de simulação, como se houvesse um piloto ao volante 

(aceleração, frenagem e direção). 

As simulações escolhidas para avaliar o projeto da suspensão são a aceleração, o skid-pad e a 

frenagem. Pelo menu Simulate>Full-vehicle Analysis>Straight-Line Events, Fig. (6.5-a), é possível 

escolher as simulações de aceleração e frenagem. Outra opção para análise da aceleração e da 

frenagem é a utilização do menu Simulate>Full-vehicle Analysis>Static and Quase-Static 

Maneuvers>Straight-Line Acceleration, Fig. (6.5-b). A diferença básica entre os dois tipos é que na 

primeira opção trabalha-se com o tempo de duração da simulação (End Time), com a discretização 

(Number of Steps), velocidade inicial (Initial Velocity), com a abertura da válvula de admissão de ar 

para o motor (Final Throttle) e o seu tempo de abertura (Duration of Step). Já na segunda opção tem-

se basicamente a quantidade de passos, a aceleração constante e a velocidade desejada.  

As simulações de frenagem são configuradas pelo menu Simulate>Full-vehicle 

Analysis>Straight-Line Events> Braking ou pelo menu Simulate>Full-vehicle Analysis>Static and 

Quase-Static Maneuvers>Straight-Line Acceleration. No segundo, basta colocar o valor negativo da 

aceleração na opção Longitudinal Accel (G’s), Fig. (6.5-b), que ficará disponível a opção de frenagem 

(braking) na janela de configuração da simulação. Esse último foi o método utilizado para simular a 

situação de frenagem. 

A simulação de aceleração e de frenagem que foram utilizadas é a segunda, Static and Quase-

Static Maneuvers> Straight-Line Acceleration, em que seus valores de entrada serão determinados na 

seção 6.2. 
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a) 

 

b) 

Figura 6. 5 - a) Janela de simulação de aceleração Straight-Line Events; b) Janela de simulação de 

aceleração do tipo Quasi-Static 

Para a simulação do skid-pad, também há dois tipos de simulações, a primeira pelo 

Simulate>Full-vehicle Analysis>Cornering Events>Constant Radius Cornering e, a segunda, pelo 

menu Simulate>Full-vehicle Analysis>Static and Quase-Static Maneuvers>Constant Radius 

Cornering. Assim como para a aceleração, no skidpad há mais opções de configuração da simulação 

no primeiro tipo, como a duração da manobra, velocidade inicial e final ou aceleração lateral inicial e 

final. No segundo tipo, trabalha-se apenas com a quantidade de passos, aceleração lateral constante. 

Em ambas as simulações têm-se a opção de entrar com o valor do raio da curva. As duas janelas de 

configuração são exibidas nas Fig. (6.6-a) e (6.6-b). 

 

a) 

 

b) 

 

Figura 6. 6 - a) Janela de simulação de skid-pad do tipo Cornering Events; b) Janela de simulação skid-pad 

do tipo Quasi-Static 
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 Os valores que serão utilizados na simulação de skid-pad serão determinados na seção 6.2. 

 

6.2 – PARÂMETROS ANALISADOS 

 Nas simulações de veículo completo desse projeto serão analisados dois parâmetros que 

conseguem sintetizar e predizer o comportamento da suspensão em um carro. Esses parâmetros são a 

força normal no pneu e o slip angle, ou ângulo de escorregamento dos pneus nas condições simuladas. 

Para isso serão variados os parâmetros de camber e toe nas simulações. 

6.2.1 – Força Normal ou Vertical 

 A força normal no pneu é um dos principais parâmetros em uma análise. Isso se deve ao fato 

de ser essa força a responsável pela aderência dos pneus com o asfalto. Quanto maior essa força, maior 

é o contato do pneu ou, como é chamado no meio automobilístico, o grip. Entretanto, como já foi dito 

na seção 5.5 e na Fig.(5.48), a partir de certa quantidade de força, o coeficiente de atrito diminui 

causando uma diminuição do atrito. Entretanto, mesmo com um coeficiente de atrito menor, procura-

se uma força com valor suficiente para poder utilizar o melhor desempenho de todo o conjunto. 

6.2.2 – Slip angle ou ângulo de escorregamento 

 Esse parâmetro já foi definido na seção 5.5. O que se procura com essa análise é encontrar a 

melhor configuração de alinhamento da suspensão que proporcione o menor ângulo de 

escorregamento possível. Quanto menor esse valor, melhor será o desempenho nas curvas, pois o 

piloto não necessitará girar mais o volante para realizar a curva e, consequentemente, diminuirá o risco 

da perda de controle do veículo, ou seja, sobre-esterçamento.  

 

6.3 – PREPARAÇÃO DAS SIMULAÇÕES 

 As simulações de aceleração, de skid-pad e de frenagem foram realizadas para uma série de 

valores de camber e de toe, que serão apresentados a seguir. Esses dois parâmetros foram variados por 

se tratarem de ajustes rápidos que podem ser feitos durante a competição. 

 As variações de camber e de toe seguiram os critérios abaixo na Tab. (6.1). O valor de camber 

das simulações de 5 a 9 foram fixados em -4º por ser um valor intermediário dentre os melhores 

resultados obtidos nas simulações do Cap. 5. E o valor de toe foi fixado em -0,5º por ser um valor 

próximo ao utilizado em carros de competição, como foi explicado no Cap. 5. 
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Tabela 6. 1 - Variação de parâmetros das simulações 

Simulação Dianteira Traseira 

 
Camber Toe Camber Toe 

1 -5 -0,5 -3 -0,5 

2 -3 -0,5 -1 -0,5 

3 -1 -0,5 0 -0,5 

4 0 -0,5 0 -0,5 

5 -4 -1 -2 -1 

6 -4 -0,5 -2 -0,5 

7 -4 0 -2 0 

8 -4 0,5 -2 0,5 

9 -4 1 -2 1 

 

 Cada simulação dessas foi feita para aceleração, para o skid-pad e para frenagem. Assim, 

obtiveram-se vinte e sete simulações, nove para cada. Sendo as simulações de 1 a 4 para a variação do 

camber e de 5 a 9 para variação do toe. 

 O software disponibiliza uma maneira fácil de trocar alguns parâmetros, sem que haja a 

necessidade de sair do modo Standard Interface para o Template Builder e reconstruir todos os 

subsistemas novamente. Para isso, basta acessar o menu Adjust>Parameter Varible>Table. Esse 

comando irá abrir uma janela, Fig.(6.7), em que é possível acessar vários parâmetros que podem ser 

modificados em todos os subsistemas ou, de uma maneira mais rápida, de toda a montagem 

(assembly). Assim, antes de cada nova simulação, foram feitas as modificações, segundo a Tab. (6.1).  

 

Figura 6. 7 – Janela de variação de parâmetros do modelo 

 

 Conforme mostrado nas Fig. (6.8-a) e (6.8-b), as suspensões duplo “A” apresentam um 

balancim e uma barra intermediária responsável por acionar o conjunto mola-amortecedor 

indiretamente, ou seja, os deslocamentos verticais da suspensão são transmitidos pela barra-balancim 

para o conjunto mola-amortecedor. Nesse sentido, considerou um modelo auxiliar, também adaptado, 

a fim de verificar a influência dessa solução construtiva nos resultados das simulações de veículo 
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completo. O modelo auxiliar, contrariamente, considera o conjunto mola-amortecedor diretamente 

fixado na bandeja inferior da suspensão. 

 Para uma melhor facilidade de indentificação durante as simulações, a partir de agora, o 

modelo mostrado na Fig. (6.8-b) será denominado suspensão como ancoragem indireta (Susp-AI) e o 

modelo auxiliar mostrado na Fig. (6.8-a), suspensão com ancoragem direta (Susp-AD). 

 

a) 

 

b) 

Figura 6. 8 –a) Modelo da suspensão com ancoragem direta – Susp-AD; b) Modelo da suspensão com 

ancoragem indireta – Susp-AI. 

 

6.3.1 – Configuração dos parâmetros de simulação 

 Para realizar as simulações, devem-se configurar as opções exibidas nas janelas de simulação,  

já apresentadas na seção 6.1.1. As simulações realizadas para a análise comparativa dos dois modelos 

de suspensão tiveram as mesmas condições de análise.  

 Nas simulações de aceleração, utilizaram-se os seguintes valores: 

 Steps: 50 

 Longitudinal Acceleration: 0,5g 

 Desired Velocity: 60 km/h 

Nas simulações de skid-pad, os valores foram: 

 Steps: 50 

 Final Lateral Acceleration: 0,5g 

 Turn Radius: 30 m 

Nas simulações de frenagem, utilizaram-se os seguintes valores: 

 Steps: 50 
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 Longitudinal Acceleration: -0,5g 

 Desired Velocity: 1 km/h 

Feitas as simulações, partiu-se para a análise dos resultados por meio de gráficos gerados pelo 

próprio programa. Esses resultados serão avaliados na seção 6.4. 

 

6.4 – RESULTADOS 

 Feitas as simulações com a variação de todos os parâmetros, serão apresentados nessa seção os 

resultados gráficos comparativos dos dois tipos de suspensão, Susp-AI e Susp-AD. Os gráficos de 

força normal para cada simulação da Tab. (6.1) se repetem para cada tipo de suspensão, ou seja, os 

gráficos das simulações de aceleração se diferem somente da Susp-AI para a Susp-AD. O mesmo 

acontece para os gráficos de skid-pad e frenagem As seções seguintes exibem os resultados gráficos 

das simulações. Na legenda de cada gráfico aparece o tipo da simulação, o tipo da suspensão (AD ou 

AI), o número referente à simulação informada na Tab. (6.1) e o pneu. Por exemplo, na legenda 

“acel_AD_01 :: Left Rear Tire Force Z” tem-se a simulação de aceleração da Susp-AD do tipo 1 para 

a força normal do pneu traseiro esquerdo. 

6.4.1 – Resultados das simulações de aceleração 

 Nessa seção serão apresentados os gráficos com os melhores resultados das simulações, ou 

seja, a maior força normal e o menor slip angle. Os outros gráficos de resultados encontram-se no 

Anexo III. 

6.4.1.1 – Força normal 

 A Fig. (6.9) apresenta o gráfico da força normal para o modelo Susp-AD e a Fig. (6.10) para a 

Susp-AI. 

 

Figura 6. 9 – Gráfico da força normal para aceleração da Susp-AD 
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Figura 6. 10 - Gráfico da força normal para aceleração da Susp-AI 

 

 Observa-se claramente que a Susp-AD fornece maior força normal aos pneus que estão sendo 

tracionados do que a Susp-AI. A diferença ainda torna-se maior se analisada como a força varia com a 

aceleração, na Fig. (6.10) percebe-se que quase não há alteração da força nos pneus tracionados 

(traseiros). A característica da Fig. (6.10) pode ser explicada pela configuração do sistema de balancim 

da suspensão, que de alguma maneira limita a transferência de peso para a condição testada. O 

esperado nesse tipo de situação é que se ganhe força normal nos pneus traseiros, o que ocorre na Fig. 

(6.9). 

6.4.1.2 – Slip angle 

 Os gráficos das Fig. (6.11) e (6.12) apresentam os melhores resultados para o escorregamento 

variando-se o camber para, respectivamente, Susp-AD e Susp-AI. Essas figuras apresentam os 

melhores valores. 

 

Figura 6. 11 - Gráfico do melhor resultado de slip angle para variação de camber - Susp-AD 
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Figura 6. 12 - Gráfico do melhor resultado de slip angle para variação de camber em aceleração- Susp-AI 

 Os melhores resultados obtidos são para as condições de camber nulo (dianteiro e traseiro), 

para a Susp-AD e -5° dianteiro e -3° traseiro, para a Susp-AI. O resultado esperado em aceleração em 

linha reta é que a variação do slip seja a menor possível, pois o desejo é que o carro ande somente em 

linha reta e que não haja desvio algum. Percebe-se que os valores de escorregamento do pneu são 

menores na Susp-AD. Quanto menor esse valor, maior é a estabilidade do veículo. 

 As Fig. (6.13) e (6.14) apresentam os resultados para a variação de toe, para Susp-AD e Susp-

AI, respectivamente. 

 

Figura 6. 13 - Gráfico do melhor resultado de slip angle para variação de toe em aceleração - Susp-AD 
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Figura 6. 14 - Gráfico do melhor resultado de slip angle para variação de toe - Susp-AI 

 Analisando os gráficos das Fig. (6.13) e (6.14), observa-se que os melhores valores de slip 

angle, para aceleração em linha reta, se dão quando seus valores são pré-determinados como nulos. 

Além disso, percebem-se melhores resultados para a Susp-AD. 

 

6.4.2 – Resultados das simulações de skid-pad 

6.4.2.1 – Força normal 

 As Fig. (6.15) e (6.16) exibem os gráficos com os resultados das forças normais sobre os 

pneus, para Susp-AD e Susp-AI, respectivamente. 

 

 

Figura 6. 15 - Gráfico da força normal para skid-pad da Susp-AD 
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Figura 6. 16 - Gráfico da força normal para skid-pad da Susp-AI 

 Na Fig. (6.15) observam-se melhores resultados para força normal do que na Fig. (6.16). 

Outro resultado importante desses gráficos é que a transferência de peso na Susp-AD é maior que na 

Susp-AI. Isso faz com que o pneu que é mais exigido na curva tenha maior força normal e, 

consequentemente, apresente maior contato com o asfalto. 

6.4.2.2 – Slip angle 

 As Fig. (6.17) e (6.18) apresentam os melhores resultados para a variação de camber nas 

simulações de skid-pad.  

 

Figura 6. 17 - Gráfico do melhor resultado de slip angle para variação de camber em skid-pad - Susp-AD 
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Figura 6. 18 - Gráfico do melhor resultado de slip angle para variação de camber em skid-pad - Susp-AI 

 

 Observa-se que na Fig. (6.17) o comportamento das curvas são mais uniformes e não há 

grandes diferenças entre elas. Já na Fig. (6.18) percebe-se uma grande variação para a roda dianteira 

esquerda. Isso pode ocorrer por alguma inconsistência no modelo computacional utilizado. 

As Fig.(6.19) e (6.20) apresentam os resultados mais satisfatórios para o slip angle dos pneus 

na simulação do skid-pad, em que houve a variação do toe das rodas. 

 

 

Figura 6. 19 - Gráfico do melhor resultado de slip angle para variação de toe em skid-pad - Susp-AD 
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Figura 6. 20 - Gráfico do melhor resultado de slip angle para variação de toe em skid-pad - Susp-AI 

 

 Observa-se na Fig. (6.19) que há o aumento gradativo do ângulo de escorregamento com o 

aumento da aceleração lateral do carro. Isso se deve ao fato de se exigir mais dos pneus e do sistema 

de direção com maior aceleração lateral. Para as rodas dianteiras da Susp-AI, Fig. (6.20), 

principalmente a esquerda, observa-se o aumento muito grande. Devido a isso, há a possibilidade de 

sub-esterçamento (understeer) da Susp-AI. Os resultados da Susp-AD, Fig. (6.19), possuem variações 

menos bruscas do que os resultados da Sups-AI na Fig. (6.20). 

6.4.3 – Resultados das simulações de frenagem 

6.4.3.1 – Força normal 

As Fig. (6.21) e (6.22) exibem os gráficos com os resultados das forças normais sobre os 

pneus, para Susp-AD e Susp-AI, respectivamente. 

 

Figura 6. 21 - Gráfico da força normal para frenagem da Susp-AD 
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Figura 6. 22 - Gráfico da força normal para frenagem da Susp-AI 

 

 Na Fig. (6.21) observa-se melhor resultado que a Fig. (6.22), pois na primeira a transferência 

de peso é maior e mais efetiva que na segunda. Percebe-se, também, que há uma maior transferência 

de peso para as rodas na Fig. (6.21) que na Fig. (6.22), isso proporciona melhor desempenho na 

frenagem. Isso ocorre porque quanto maior a força normal, maior será a força de atrito do pneu com o 

solo e evita-se que o pneu deslize em uma frenagem brusca.  

 

6.4.3.2 – Slip angle 

 As Fig. (6.23) e (6.24) mostram os resultados do escorregamento lateral dos pneus sob a 

situação de frenagem para a variação de camber. 

 

 

Figura 6. 23 - Gráfico do melhor resultado de slip angle para variação de camber em frenagem - Susp-AD 
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Figura 6. 24 - Gráfico do melhor resultado de slip angle para variação de camber em frenagem - Susp-AI 

 

 As Fig. (6.25) e (6.26) mostram os resultados do escorregamento lateral dos pneus sob a 

situação de frenagem para a variação de toe. 

 

 

Figura 6. 25 - Gráfico do melhor resultado de slip angle para variação de toe em frenagem - Susp-AD 

 

 

Figura 6. 26 - Gráfico do melhor resultado de slip angle para variação de toe em frenagem - Susp-AI 
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 Para a Susp-AD, Fig. (6.23) e (6.25), observam-se baixos valores e uma pequena variação do 

slip angle com a frenagem. Já nas Fig. (6.24) e (6.26) observa-se que a variação não é tão grande com 

o aumento da aceleração, porém seus valores são relativamente maiores se comparados aos resultados 

da Susp-AD. Isso ocorreu tanto para variação de camber quanto para variação de toe. 

 

 

6.5 – DISCUSSÕES 

 Os resultados das simulações apresentam um bom comportamento do carro sob as condições 

testadas. Percebe-se que o comportamento da Susp-AD foi superior ao da Susp-AI. Acredita-se que 

isso se deve ao fato de a Susp-AI ter sua construção mais complexa, envolvendo vários graus de 

liberdade, não presentes no outro modelo. Essa diferença pode ser explicada pela configuração dos 

vetores de forças que compõem esse sistema, pela geometria da peça que faz a conexão da bandeja 

inferior com a mola (balancim ou rocker). Para que se possam ter resultados melhores deve-se 

melhorar o projeto do rocker, quanto a posicionamento e dimensões. Com isso, pode-se garantir que o 

Susp-AI possa ter funcionamento equivalente ao da Susp-AD. Com certeza os resultados da Susp-AI 

podem ser melhorados se fizer o projeto geométrico detalhado das transmissões de força da bandeja 

inferior para a mola.  

 Para a simulação de aceleração, fica evidente que a Susp-AD tem melhor desempenho quanto 

à força e ao escorregamento do pneu. A força normal irá prover maior atrito aos pneus, 

consequentemente, proporcionará a melhor transmissão de torque do motor aos pneus. Quanto ao 

escorregamento, os valores são baixos e poderão prejudicar muito pouco o desempenho do carro na 

aceleração em linha reata. Além do que, a influência do slip é maior em curvas. 

 Para a simulação de skid-pad, mais uma vez a Susp-AD possui melhor desempenho. Quanto à 

força normal, o ganho de força na roda dianteira externa à curva (esquerda) é altamente benéfico para 

o melhor desempenho, uma vez que essa roda é a maior responsável por fazer a curva. Percebe-se, 

também, a maior transferência de peso na Susp-AD do que na Susp-AI para as rodas dianteiras. Para o 

escorregamento, a Susp-AD apresenta valores menores do que a Susp-AI. O valor de slip está 

relacionado com o coeficiente de atrito dos pneus Fig. (6.27), segundo (Smith, 1978). O gráfico da 

Fig. (6.27) exibe a variação do coeficiente de atrito com o slip angle para quatro tipos de pneu. 

Observa-se o ganho de atrito até certa quantidade de slip e, depois, a queda desse valor. Optou-se por 

escolher os menores valores de slip por se tratar de um modelo computacional que envolve várias 

aproximações, uma delas é quanto ao composto da borracha do pneu e suas características. Em uma 

situação real, os resultados podem ser superiores e, escolhendo os valores mais baixos das simulações, 

evita-se que a configuração geométrica da suspensão proporcione valores de slip grandes o suficiente 

para haver o decrescimento do coeficiente de atrito e, consequentemente, perda de desempenho do 

veículo. 
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 Para as simulações de frenagem, a Susp-AD teve melhor desempenho do que a Susp-AI. Para 

os resultados da força normal, observa-se que a transferência de peso na Susp-AD é maior do que na 

Susp-AI. Isso favorece a frenagem, visto que o carro exige mais dos freios dianteiros do que dos 

traseiros nessa situação. Para o escorregamento lateral dos pneus, os valores da Susp-AD são menores, 

o que proporciona melhor alinhamento do carro e, consequentemente, maior controle e estabilidade 

durante frenagens. 

 

Figura 6. 27 - Gráfico Slip angle X Coeficiente de atrito - Ref.: Smith (1978) 

 

 Como o objetivo desse trabalho é obter resultados dos valores de geometria e de alinhamento 

da suspensão do carro de Fórmula SAE da Apuama Racing, essa seção apresenta a Tabela (6.2) com 

esses valores. Nessa tabela são encontrados os valores dos parâmetros de camber e toe que tiveram 

melhores resultados nas simulações apresentadas nesse capítulo. 

 

Tabela 6. 2 - Tabela de valores de alinhamento da suspensão 

 
Dianteira Traseira 

Prova Camber (°) Toe (°) Camber (°) Toe (°) 

Aceleração 0 ≈ 0 0 ≈ 0 

Skid-pad -3 -0,5
7
 ≈ -1 -0,5

7 

Frenagem -4 -1 ≈ -2 -1 

 

 Os valores informados na tabela servirão como ponto de partida para a configuração da 

suspensão. Esses valores devem ser ajustados durante a competição, se necessário.   

                                                 
7
 Valor de toe negativo indica divergência. 
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7 – CONCLUSÕES 
 

 

 

O que se busca em um carro de corrida é o melhor contato possível dos pneus com o solo. Para 

isso, os projetistas trabalham para tentar solucionar problemas que façam com que o carro perca atrito 

com asfalto e, consequentemente, o piloto possa exigir o máximo desempenho de seu veículo. 

Esse projeto conseguiu definir as etapas de desenvolvimento da geometria de uma suspensão 

automotiva de competição, além de dar uma pequena noção sobre os recursos e a utilização do 

software ADAMS/Car da MSC Software.  

As simulações de cada suspensão, dianteira e traseira, servem para dar noção do 

comportamento da suspensão (em relação à geometria) após sua montagem no chassi. Entretanto, as 

simulações de veículo completo são de fundamental importância para visualizar o provável 

comportamento do carro sobre as mais diversas condições. Com as simulações de aceleração, skid-pad 

e de frenagem buscou-se predizer o comportamento que o carro poderá ter em condições semelhantes 

às simuladas. Diz-se predizer, por se tratar de um modelo computacional que envolve várias 

aproximações e a construção “perfeita” da geometria, onde pode haver a precisão milimétrica do 

posicionamento dos componentes. Essa precisão de construção não ocorre em um tipo de fabricação 

artesanal, como é a de um Fórmula SAE. Além dos problemas construtivos, há uma série de 

considerações quanto à rigidez do chassi, peso final do carro, qualidade e tipo dos pneus, 

amortecedores e molas, dentre outros.  

A partir das análises do veículo completo, pôde-se perceber que para provas que envolvam 

curvas, uma ligeira divergência entre as rodas proporciona menor escorregamento dos pneus, mesmo 

que essa divergência seja prejudicial quanto à instabilidade em retas. Em um circuito misto, 

recomenda-se um valor baixo para esse parâmetro. Seu melhor ajuste é dado pelo desgaste dos pneus, 

além da avaliação do piloto.  

Quanto ao camber, sua função é compensar a rolagem do carro e seu valor depende da 

solicitação do circuito. Dessa maneira, as simulações computacionais dão um valor inicial para 

determinada situação, mas sua confirmação depende da avaliação da temperatura dos pneus na pista, 

mas, mesmo assim, recomenda-se a utilização de camber negativo. Nas simulações estáticas no Cap. 

5, observaram-se comportamentos indesejados nas simulações para camber positivo. 

Com o surgimento da ideia de comparar duas suspensões com geometrias idênticas, porém 

com diferentes disposições da mola e do amortecedor, enriqueceu-se o trabalho e ganhou-se quanto a 

futuras possibilidades de trabalho. Na avaliação dos resultados do Cap. 6 comentou-se sobre a 

diferença entre as duas suspensões e seus possíveis problemas. 
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Um dos intuitos desse texto é servir como o primeiro documento para a criação do acervo de 

projetos da equipe Apuama Racing. Por ser um projeto pioneiro na questão de configuração de 

suspensão automotiva para melhor desempenho, espero contribuir para que a equipe se mantenha na 

ativa, que se fortaleça e abra caminho para maior cooperação entre alunos e professores no 

desenvolvimento de projetos para, cada vez mais, ganhar visibilidade e respeito. 
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9 – ANEXO I 

TIPOS DE SUSPENSÃO 
 

 
Esse anexo foi retirado do capítulo 3 do Projeto de Graduação do aluno Rafael Areal da 

Universidade de Brasília. Esse texto foi introduzido como anexo por conter um bom apanhado dos 

tipos de suspensão existentes. Algumas suspensões que aparecem no texto foram citados 

anteriormente nesse trabalho.  

 

9.4 TIPOS DE SUSPENSÃO 

9.4.1 SUSPENSÕES INDEPENDENTES 

9.4.1.1 SUSPENSÃO MCPHERSON 

 
Este tipo de suspensão é muito encontrado em eixos dianteiros de veículos de passeio. 

Também pode ser aplicada em eixos traseiros. Trata-se de um braço transversal inferior e o conjunto 

mola amortecedor agindo como um braço de controle. 

 

 

Figura 9.38. Suspensão dianteira McPherson de um Porsche 911 Carrera 4 (1998) , segundo Reimpell 

et. Al (2006). 

 

 

Esta configuração possibilita as seguintes vantagens e desvantagens: 
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Vantagens: 

• Simplicidade; 

• É um sistema leve, compacto e de baixo custo; 

• Baixa transmissibilidade; 

• Apenas dois pontos de fixação na estrutura do veículo são necessários. 

 

Desvantagens: 

• O fuso do amortecedor pode ser submetido à flexão, tendo que ser reforçado; 

• O atrito entre o pistão e o fuso do amortecedor prejudica o desempenho do sistema; 

• Alto nível de vibrações transmitidas ao veículo, reduzindo o conforto; 

• Possibilidade de definição de centro de rolagem reduzido e dependente da inclinação do 

kingpin e do kingpin off-set; 

• Ângulo de caster dependente do centro de pitch; 

• Difícil controle da cambagem e variação da bitola de eixo. 

As forças absorvidas pelo conjunto mola-amortecedor podem ser reduzidas introduzindo-se 

um terceiro ponto de fixação para resistir às forças longitudinais e laterais. Assim, o atrito entre o 

pistão e o fuso do amortecedor é reduzido. 

As vibrações transmitidas à estrutura do veículo podem ser solucionadas pelo estudo destas 

vibrações, com o objetivo de se projetar uma peça de fixação que resolva este problema sem que 

prejudique no controle da posição da roda. 

As alterações de cambagem e bitola de eixo podem ser reduzidas aumentando-se o tamanho 

dos braços inferiores. Em um caso extremo utilizado em veículos de competição off-road, os braços se

 cruzam. 

 

Figura 0.39. Variação da cambagem e da bitola de eixo em uma suspensão McPherson, segundo 

Reimpell et.al (2006). 
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Para que se encontre o centro de rolagem de uma suspensão McPherson é preciso traçar uma 

reta paralela à reta que passa pelo ponto de fixação da mola-amortecedor na estrutura do veículo e o 

ponto de fixação do braço inferior na manga de eixo. Esta reta deve interceptar o primeiro ponto. O 

centro de rolagem então, será dado pela intersecção desta reta com o prolongamento do braço inferior. 

 

 

Figura 9.40. Centro de rolagem RO à altura hRo em uma suspensão McPherson, segundo Reimpell et. 

Al (2006). 

 

 

Como a inclinação do kingpin e conseqüentemente o off-set de kingpin são também 

relacionados com a reta EG, estes parâmetros e o centro de rolagem são dependentes entre si. 

Analogamente, o ângulo de caster influencia no centro de pitch sendo que ambos variam de acordo 

com o trabalho da suspensão, pois a angulação longitudinal da reta EG varia. 

 

 

Figura 9.41. Relação entre a inclinação de kingpin e o centro de pitch em uma suspensão McPherson, 

segundo Reimpell et. al (2006). 
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9.4.1.2 SUSPENSÃO DUPLO-A (DOUBLE WISHBONE) 

Em casos em que o controle do veículo está acima de outros fatores, a melhor solução é 

normalmente a utilização de uma suspensão Duplo-A. Isto se deve ao fato de que os parâmetros deste 

tipo de suspensão podem ser escolhidos de modo mais livre com relação à maioria dos outros tipos de 

suspensão. Ela consiste basicamente de dois braços em forma de “A” superpostos e pode ser utilizada 

tanto em eixos dianteiros quanto traseiros. O amortecedor e a mola podem ser apoiados tanto em um 

dos braços quanto na manga de eixo. 

 

 

Figura 9.42. Suspensão traseira Duplo-A de um Audi A4 Quattro. Os braços superiores estão 

indicados pelo número 5, enquanto os braços inferiores estão indicados pelo número 4, segundo 

Reimpell et. al (2006). 

 

Este tipo de suspensão fornece as seguintes vantagens e desvantagens: 

 

Vantagens: 

• Controle mais preciso da cambagem; 

• Melhor controle das variações elástico-cinemáticas da cambagem e da convergência; 

• Ampla gama de escolha da altura dos centros de rolagem e pitch; 

• Pequena variação de bitola de eixo; 

• Pouca vibração transmitida à estrutura do veículo. 

 

Desvantagens: 

 

• Necessita de espaço considerável; 

• Custo mais elevado em comparação à outros tipos de suspensão. 
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A liberdade de escolha da variação de cambagem provém das inúmeras possibilidades de se 

combinar o tamanho dos braços de suspensão. Como regras gerais, quanto mais longo o braço inferior, 

menor a variação de bitola de eixo, e quanto menor o braço superior em relação ao inferior, mais 

negativa será a cambagem em compressão e mais positiva será em extensão. Obviamente, o efeito 

combinado dos tamanhos e angulações dos braços é que irão ditar a cambagem. Logo, o controle da 

posição da roda é tal que é possível projetar uma suspensão que forneça a cambagem ideal em curvas 

ou obstáculos.  

O centro de rolagem é facilmente encontrado na suspensão Duplo-A. É dado pela intersecção 

do prolongamento dos dois braços. 

 

 

Figura 9.43. Centro de rolagem RO à altura hRo em uma suspensão Duplo-A, segundo Reimpell et. al 

(2006). 

 

Variando-se a angulação dos braços, pode-se obter praticamente qualquer posição desejada 

para o centro de rolagem. Nota-se que, diferentemente da suspensão McPherson, o centro de rolagem 

é independente da inclinação do kingpin e do kingpin off-set. No caso em que os braços são paralelos 

entre si, o centro de rolagem está no infinito. Entretanto, como a altura do centro de rolagem é definida 

como sendo contida no plano central do veículo, ela pode estar apenas a poucos milímetros do solo. 

 

Figura 9.44. Centro de rolagem de uma suspensão Duplo-A no caso em que seus braços são paralelos 

entre si, segundo Reimpell et. al (2006). 

O centro de pitch é dado pela angulação dos braços entre si em relação ao eixo y. No caso em 

que os freios dianteiros são localizados no interior do sistema de transmissão (fig. 9.45), os braços 

devem estar inclinados na mesma direção para que haja anti-dive. Caso os freios estejam dentro das 
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rodas (fig. 9.46), os braços devem estar inclinados na mesma direção. Isto ocorre porque quando o 

freio está localizado no interior da roda, as forças geradas pelo atrito da pastilha com o disco (ou 

tambor) devem ser resistidas pelos braços de suspensão. 

 

Figura 9.45. Diagrama de forças relacionando o mecanismo de anti-dive com uma força de frenagem 

no caso em que o freio se localiza no interior do sistema de transmissão, segundo Reimpell et. al 

(2006). 

 

 

Figura 9.46. Diagrama de forças relacionando o mecanismo de anti-dive com uma força de frenagem 

no caso em que o freio se localiza no interior das rodas, segundo Reimpell et. al (2006). 

 

Se o veículo possui tração dianteira e freios no interior da roda, então o mecanismo de anti-

dive também funciona como anti-squat se apenas o braço inferior estiver angulado. A desvantagem de 

se ter uma diferença de angulação entre os braços é que o caster varia com o trabalho da suspensão. A 

angulação dos braços também pode causar movimentos longitudinais indesejados. Porém, em certos 

casos uma angulação inversa ao anti-dive pode ser introduzida para diminuir o impacto das rodas com 

obstáculos e, conseqüentemente, reduzir os esforços sobre os elementos da suspensão.  

A situação é análoga quando se define o centro de pitch do eixo traseiro, mas neste caso a 

angulação é na direção contrária. Uma variação interessante deste tipo de suspensão é a utilizada em 



   97 

veículos de alto desempenho como é o caso de alguns modelos de Ferrari, Lamborghini e veículos de 

competição on-road como os carros de Fórmula-1. Tanto por razões de espaço, quanto por menor 

massa não-suspensa, melhor desempenho e por menores arrastos aerodinâmicos (caso dos carros de F1 

nos quais a maioria dos elementos da suspensão são expostos), as molas e amortecedores formam um 

conjunto instalado no interior da estrutura do veículo e podem estar dispostos em qualquer posição. A 

transmissão de forças é feita por meio de um braço ligado à um mecanismo de biela-manivela. 

 

 

Figura 9.47. Sistema de suspensão com biela. 

 

Uma grande vantagem deste tipo de suspensão é que pode ser projetada de modo que uma 

pequena variação de movimento das rodas cause um grande deslocamento do conjunto mola-

amortecedor, assegurando um bom do funcionamento do amortecedor. Por este motivo, é ideal para 

veículos de rua que possuem curso de suspensão reduzido. 

 

9.4.1.3 SUSPENSÃO MULTI-LINK 

A suspensão Duplo-A no eixo traseiro não fornece um controle preciso de convergência das 

rodas. Para suprir esta deficiência existe a suspensão Multi-Link que consiste em três a cinco braços 

de controle. A grande vantagem deste tipo de suspensão traseira é que todos os parâmetros podem ser 

controlados de forma independente assim como na dianteira Duplo-A. Se uma suspensão traseira 

Duplo-A possuir um braço de controle de convergência também pode ser classificada como Multi- 

Link. 
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Figura 9.48. Suspensão traseira Multi-link de uma BMW Série 5 (E39, 1996) , segundo Reimpell et. 

Al (2006). 

Em alguns casos, os braços e/ou as buchas são projetados para sofrerem deformações com o 

trabalho da suspensão, como é o caso da suspensão do Ford Focus (1998) em que o braço longitudinal 

sofre torção.  

 

Figura 9.49. Suspensão traseira Multi-link de um Ford Focus (1998) modelo europeu, segundo 

Reimpell et. al (2006) 
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Este tipo de suspensão possui a desvantagem de possuir um custo mais elevado com relação às 

suspensões à que normalmente substitui (Duplo-A e Semi-Trailing-Arm), porém pode fornecer ótimos 

desempenhos. 

É difícil a generalização da definição de parâmetros tipo de suspensão, pois o arranjo dos 

braços pode ser o mais variado possível, portanto, não será feita. 

 

9.4.1.4 SUSPENSÃO TRAILING-ARM 

Utilizada em eixos traseiros de veículos com tração traseira, a suspensão Trailing-Arm 

consiste apenas de braços longitudinais que são responsáveis pela transmissão de forças longitudinais 

e laterais. Logo, está sujeita a esforços diversos. Pela sua simplicidade e baixo custo, é largamente 

utilizada em veículos de passeio de baixo custo. 

 

 

 

Suas principais vantagens e desvantagens são: 

Vantagens: 

• Simples e compacto; 

• Baixo custo; 

• Sem variação de bitola de eixo; 

• Massa não-suspensa reduzida. 

Desvantagens: 

• Centro de rolagem sempre na altura do solo; 

• Pequena variação de cambagem no sentido de prejudicar o desempenho; 

• Tendência elástico-cinemática ao sobre-esterçamento devido à forças laterais. 
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A altura do centro de rolagem da suspensão Trailing-Arm se encontra no solo, pois a aplicação 

deuma força lateral no pneu apenas causa a flexão do braço longitudinal e não influencia na rolagem 

doveículo. O centro de pitch se localiza na fixação do braço longitudinal com a estrutura do veículo e, 

portanto fornece anti-dive. 

 

 

Figura 9.51. Altura do centro de rolagem RO e centro de pitch em uma suspensão Trailing-Arm, 

segundoReimpell et. al (2006). 

 

9.4.1.5 SUSPENSÃO SEMI-TRAILING-ARM 

Este tipo de suspensão consiste em uma variação da Trailing-Arm. Consiste em um braço de 

controle fixado à dois pontos da estrutura do veículo. Assim, é possível realizar um certo controle 

sobre a convergência e a cambagem, além de ser possível a definição de um centro de rolagem à uma 

altura desejada, diferentemente da suspensão Trailing-Arm, na qual o centro de rolagem se encontra 

inevitavelmente no solo. 

 

Figura 9.52. Suspensão traseira Semi-Trailing-Arm de um Opel Omega (1999) , segundo Reimpell et. 

Al (2006). 
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As seguintes vantagens e desvantagens gerais são atribuídas à suspensão Semi-Trailing-Arm: 

Vantagens: 

• Possibilidade de definição do centro de rolagem e pitch; 

• Boa capacidade de controle de cambagem e convergência. 

Desvantagens: 

• Necessita de mais espaço em relação à Trailing-Arm; 

• Tendência elástico-cinemática ao sobre-esterçamento; 

• Dependência da cambagem e da convergência; 

• Pequena variação de bitola de eixo. 

O centro de rolagem de uma suspensão Semi-Trailing-Arm é encontrado da seguinte maneira: 

Traça-se uma reta unindo os pontos de fixação da suspensão na estrutura do veículo no plano xy e 

marca-se um ponto em que esta reta intersecta uma linha perpendicular ao centro da roda. Este ponto 

define a posição transversal do centro do rolagem. Traça-se então uma reta unindo os mesmos pontos, 

mas desta vez no plano zy. O centro de rolagem estará sobre esta reta, à distância transversal 

encontrada anteriormente. 

 

Figura 9.53. Definição do centros de rolagem de uma suspensão Semi-Trailing-Arm, segundo 

Reimpell et. Al (2006). 

 

 

O centro de pitch é encontrado de maneira análoga. 
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Figura 9.54. Definição do centro de pitch de uma suspensão Semi-Trailing-Arm, segundo Reimpell 

et. Al (2006). 

9.4.2 SUSPENSÕES DE EIXO RÍGIDO 

As suspensões rígidas costumam serem utilizadas em veículos comerciais como caminhões e 

ônibus, em caminhonetes e também em veículos off-road. São normalmente utilizados feixes de molas 

longitudinais ao invés de molas helicoidais, pois este tipo de suspensão costuma visar o custo ao invés 

do desempenho. Uma vantagem deste tipo de mola é que ela pode ser o único elemento de fixação da 

suspensão no chassis do carro pois pode transmitir forças em todas as direções. Podem ser utilizadas 

tanto no eixo dianteiro quanto no traseiro. As vantagens e desvantagens gerais deste tipo de suspensão 

estão listadas a seguir: 

Desvantagens: 

• Dependência de uma roda em relação à outra; 

• Necessitam de grande espaço disponível acima do eixo; 

• Potencial limitado para ajustes finos; 

• Massa não suspensa elevada caso se utilize um diferencial; 

• Diferenças de carga nos pneus caso haja um diferencial. 

Vantagens: 

• Simplicidade, ou seja, menor quantidade de elementos; 

• Econômicos em sua fabricação; 

• Não produz variações de bitola de eixo, convergência e cambagem; 

• Não produz variações de cambagem durante curvas; 

• O esterçamento causado pelos efeitos elástico-cinemáticos pode ser ajustado para sub ou 

sobre-esterçamento. 
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Figura 9.55. Suspensão de eixo rígido de um veículo Volkswagen LT utilizando feixe de molas, 

segundo Reimpell et. al (2006). 

As suspensões de eixo-rígido ainda possuem a vantagem de poderem ser montadas em uma 

ampla gama de posições com relação à sub-estrutura do chassis. Isto permite que a distância entre as 

montagens das molas sejam tais que quando o veículo se encontra sob carregamentos elevados (caso 

de caminhões, por exemplo) o peso é melhor distribuído no chassis e isso faz com que as tensões nele 

sejam reduzidas. Ele pode ainda possuir uma barra-antirolagem para minimizar a rolagem lateral do 

veículo. 

A altura do centro de rolagem de uma suspensão rígida que transmite todas as forças através 

dos feixes de molas se localiza no centro de seu feixe principal. Os mecanismos de anti-dive e anti-

squat podem ser fornecidos pela inclinação das molas, ou seja, pela diferença de altura entre as 

fixações das molas. Ao mesmo tempo, pode causar sobre ou sub-esterçamento do eixo como mostrado 

na figura. 
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Figura 9.56. Sub-esterçamento causado pelos deslocamentos dos feixes de molas, segundo Reimpell 

et. Al (2006). 

Uma variação de suspensão de eixo rígido é feita utilizando-se molas helicoidais, braços 

longitudinais para transmitir forças longitudinais e uma barra panhard, que realiza a transmissão de 

forças laterais. Esta barra panhard é montada em um dos lados da suspensão e se extende até o outro 

lado, onde é fixada à estrutura do carro. 

 

Figura 9.57. Suspensão traseira de eixo rígido de um Mitsubishi Pajero. A barra panhard está 

indicada pelo número 4, segundo Reimpell et. al (2006). 
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Em uma suspensão que transmite as forças laterais por meio de uma barra panhard, seu centro 

de rolagem se localiza na intersecção da barra e do plano central do veículo em uma vista traseira. 

 

 

Figura 9.58. Centro de rolagem em uma suspensão que utiliza barra panhard, segundo Reimpell et. 

Al (2006). 

Outra variação interessante é a conhecida como Four Bar Links. São utilizados dois braços de 

controle inferiores e dois braços de controle superiores, cada par com determinadas angulações de 

modo a produzir os centros de rolagem e pitch. Estes braços são responsáveis por transmitir tanto as 

forças longitudinais quanto laterais. 

 

Figura 9.59. Suspensão Four Bar Links. 

 



   106 

9.4.3 SUSPENSÕES DE EIXO SEMI-RÍGIDO 

A suspensão de eixo semi-rígido é a mais utilizada em eixos traseiros de carros de passeio de 

tração dianteira nos dias de hoje. Isto se deve ao seu baixo custo unido ao seu relativo bom 

desempenho. Consiste em dois braços longitudinais soldados a um membro que une as rodas. Este 

membro possui uma rigidez à torção de tal maneira que permite o movimento de uma roda em relação 

à outra de modo semi-independente funcionando como uma barra anti-rolagem. 

 

Figura 9.60. Suspensão traseira de eixo semi-rígido utilizada em Volkswagen Golf IV (1997), 

Volkswagen Bora (1999) e Audi A3 (1996) , segundo Reimpell et. al (2006). 

Vantagens: 

As características gerais das suspensões semi-rígidas são: 

• Fácil instalação e manutenção; 

• Pouco espaço necessário; 

• Simples e de baixo custo; 

• Apenas dois pontos de fixação na estrutura do veículo; 

• Massa não suspensa reduzida; 

• Insignificantes variações de convergência e bitola de eixo com o trabalho paralelo ou 

recíproco da suspensão; 

• Pequenas variações de cambagem em curvas; 

• Grande liberdade para projetar o centro de pitch traseiro, pondendo-se reduzir 

consideravelmente o levantamento da traseira do veículo. 

Desvantagens: 
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• Tendência ao sobre-esterçamento em curvas; 

• Limitações quanto ao controle das rodas; 

• Alto nível de vibrações causando desconforto; 

• A estrutura do veículo deve ser bem reforçada nos pontos de fixação, pois recebem cargas 

superpostas em todas as direções. 
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10 – ANEXO II 

RESUMO DO PROJETO 
 

 

FSAE Suspension Datasheet 

Dados Gerais 

Altura CG 330mm 
  

Localização longitudinal 1200mm 
  

Distância entre-eixos 1700mm 
  

%Frenagem dianteira 60% 
  

Dianteira 

 
Ponto X (mm) Y(mm) Z(mm) 

Localização 

1-Bandeja inferior: frente 0 190 130 

2-Bandeja inferior: detrás 330 190 150 

3-Bandeja inferior: externo 150 580 140 

4-Bandeja superior: frente 0 190 360 

5-Bandeja superior: detrás 330 310 300 

6-Bandeja superior: externo 163 555 360 

Dados  

Geometria vista frontal 

Altura CI frontal 68,36mm 

Altura centro de 

rolagem 
15,84mm 

Comprimento FVSA 

frontal 
2220,6mm 

Ângulos da manga de eixo 
Ângulo kingpin 6,48° 

Ângulo caster 4° 

Geometria vista lateral 

Altura CI lateral 225,0mm 

Comprimento SVSA 1402,5mm 

Ângulo ϕF 9,11° 

Anti-dive 49,56% 

Mola (utilizada na simulação) Constante 101,93 N/mm 

Traseira 

 
Ponto X (mm) Y(mm) Z(mm) 

Localização 

1-Bandeja inferior: frente 1610 173 130 

2-Bandeja inferior: detrás 2010 155 115 

3-Bandeja inferior: externo 1860 600 145 

4-Bandeja superior: frente 1610 203 308 

5-Bandeja superior: detrás 2010 155 330 

6-Bandeja superior: externo 1885 575 352 

Dados  Geometria vista frontal 

Altura CI frontal 56,3mm 

Altura centro de 

rolagem 
17,75mm 

Comprimento FVSA 1925,0mm 
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Ângulos da manga de eixo 
Ângulo kingpin 6,89° 

Ângulo caster 4° 

 

Geometria vista lateral 

Altura CI lateral 234,44mm 

Comprimento SVSA 1766,1mm 

Ângulo ϕR 7,56° 

Anti-dive 64,66% 

Mola (utilizada na simulação) Constante 77,5 N/mm 
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11 – ANEXO III 

GRÁFICOS  
 

 Nesse anexo serão apresentados todos os gráficos das simulações de veículo completo. 

Esses gráficos não foram apresentados no Cap. 6, juntamente com os outros, para evitar a 

poluição do texto. 

 A configuração de cada simulação encontra-se na Tab. 6.1 do Cap. 6.  

11.1 – Aceleração Susp-AI 

 

Figura 11. 1 - Força normal da simulação acel_01 - Susp-AI 

 

Figura 11. 2 - Escorregamento lateral (slip) da simulação acel_01 - Susp-AI 
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Figura 11. 3 - Força normal da simulação acel_02 - Susp-AI 

 

Figura 11. 4 - Escorregamento lateral (slip) da simulação acel_02 - Susp-AI 

 

 

Figura 11. 5 - Força normal da simulação acel_03 - Susp-AI 
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Figura 11. 6 - Escorregamento lateral (slip) da simulação acel_03 - Susp-AI 

 

 

Figura 11. 7 - Força normal da simulação acel_04 - Susp-AI 

 

Figura 11. 8 - Escorregamento lateral (slip) da simulação acel_04 - Susp-AI 
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Figura 11. 9 - Força normal da simulação acel_05 - Susp-AI 

 

Figura 11. 10 - Escorregamento lateral (slip) da simulação acel_05 - Susp-AI 

 

 

Figura 11. 11 - Força normal da simulação acel_06 - Susp-AI 
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Figura 11. 12 - Escorregamento lateral (slip) da simulação acel_06 - Susp-AI 

 

 

Figura 11. 13 - Força normal da simulação acel_07 - Susp-AI 

 

Figura 11. 14 - Escorregamento lateral (slip) da simulação acel_07 - Susp-AI 

 



   115 

 

Figura 11. 15 - Força normal da simulação acel_08 - Susp-AI 

 

Figura 11. 16 - Escorregamento lateral (slip) da simulação acel_08 - Susp-AI 

 

 

Figura 11. 17 - Força normal da simulação acel_09 - Susp-AI 
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Figura 11. 18 - Escorregamento lateral (slip) da simulação acel_09 - Susp-AI 

 

 

11.2 – Aceleração Susp-AD 

 

Figura 11. 19 - Força normal da simulação acel_01 - Susp-AD 

 

 

Figura 11. 20 - Escorregamento lateral (slip) da simulação acel_01 - Susp-AD 
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Figura 11. 21 - Força normal da simulação acel_02 - Susp-AD 

 

Figura 11. 22 - Escorregamento lateral (slip) da simulação acel_02 - Susp-AD 

 

 

Figura 11. 23 - Força normal da simulação acel_03 - Susp-AD 
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Figura 11. 24 - Escorregamento lateral (slip) da simulação acel_03 - Susp-AD 

 

 

Figura 11. 25 - Força normal da simulação acel_04 - Susp-AD 

 

 

Figura 11. 26 - Escorregamento lateral (slip) da simulação acel_04 - Susp-AD 
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Figura 11. 27 - Força normal da simulação acel_05 - Susp-AD 

 

 

Figura 11. 28 - Escorregamento lateral (slip) da simulação acel_05 - Susp-AD 

 

 

Figura 11. 29 - Força normal da simulação acel_06 - Susp-AD 
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Figura 11. 30 - Escorregamento lateral (slip) da simulação acel_06 - Susp-AD 

 

 

Figura 11. 31 - Força normal da simulação acel_06 - Susp-AD 

 

 

Figura 11. 32 - Escorregamento lateral (slip) da simulação acel_07 - Susp-AD 
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Figura 11. 33 - Força normal da simulação acel_08 - Susp-AD 

 

 

Figura 11. 34 - Escorregamento lateral (slip) da simulação acel_08 - Susp-AD 

 

 

Figura 11. 35 - Força normal da simulação acel_09 - Susp-AD 
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Figura 11. 36 - Escorregamento lateral (slip) da simulação acel_09 - Susp-AD 

 

 

11.3 – Skid-pad Susp-AI 

 

Figura 11. 37 - Força normal da simulação skid_01 - Susp-AI 

 

 

Figura 11. 38 - Escorregamento lateral (slip) da simulação skid_01 - Susp-AI 
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Figura 11. 39 - Força normal da simulação skid_02 - Susp-AI 

 

Figura 11. 40 - Escorregamento lateral (slip) da simulação skid_02 - Susp-AI 

 

 

Figura 11. 41 - Força normal da simulação skid_03 - Susp-AI 
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Figura 11. 42 - Escorregamento lateral (slip) da simulação skid_03 - Susp-AI 

 

 

Figura 11. 43 - Força normal da simulação skid_04 - Susp-AI 

 

 

Figura 11. 44 - Escorregamento lateral (slip) da simulação skid_04 - Susp-AI 
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Figura 11. 45 - Força normal da simulação skid_05 - Susp-AI 

 

 

Figura 11. 46 - Escorregamento lateral (slip) da simulação skid_05 - Susp-AI 

 

 

Figura 11. 47 - Força normal da simulação skid_06 - Susp-AI 
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Figura 11. 48 - Escorregamento lateral (slip) da simulação skid_06 - Susp-AI 

 

 

Figura 11. 49 - Força normal da simulação skid_07 - Susp-AI 

 

 

Figura 11. 50 - Escorregamento lateral (slip) da simulação skid_07 - Susp-AI 
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Figura 11. 51 - Força normal da simulação skid_08 - Susp-AI 

 

 

Figura 11. 52 - Escorregamento lateral (slip) da simulação skid_08 - Susp-AI 

 

 

Figura 11. 53 - Força normal da simulação skid_09 - Susp-AI 
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Figura 11. 54 - Escorregamento lateral (slip) da simulação skid_09 - Susp-AI 

 

 

 

11.4 – Skid-pad Susp-AD 

 

Figura 11. 55 - Força normal da simulação skid_01 - Susp-AD 

 

Figura 11. 56 - Escorregamento lateral (slip) da simulação skid_01 - Susp-AD 
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Figura 11. 57 - Força normal da simulação skid_02 - Susp-AD 

 

Figura 11. 58 - Escorregamento lateral (slip) da simulação skid_02 - Susp-AD 

 

 

Figura 11. 59 - Força normal da simulação skid_03 - Susp-AD 
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Figura 11. 60 - Escorregamento lateral (slip) da simulação skid_03 - Susp-AD 

 

 

Figura 11. 61 - Força normal da simulação skid_04 - Susp-AD 

 

 

Figura 11. 62 - Escorregamento lateral (slip) da simulação skid_04 - Susp-AD 
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Figura 11. 63 - Força normal da simulação skid_05 - Susp-AD 

 

 

Figura 11. 64 - Escorregamento lateral (slip) da simulação skid_05 - Susp-AD 

 

 

Figura 11. 65 - Força normal da simulação skid_06 - Susp-AD 
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Figura 11. 66 - Escorregamento lateral (slip) da simulação skid_06 - Susp-AD 

 

 

Figura 11. 67 - Força normal da simulação skid_07 - Susp-AD 

 

 

Figura 11. 68 - Escorregamento lateral (slip) da simulação skid_07 - Susp-AD 
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Figura 11. 69 - Força normal da simulação skid_08 - Susp-AD 

 

 

Figura 11. 70 - Escorregamento lateral (slip) da simulação skid_08 - Susp-AD 

 

 

Figura 11. 71 - Força normal da simulação skid_09 - Susp-AD 
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Figura 11. 72 - Escorregamento lateral (slip) da simulação skid_09 - Susp-AD 

 

11.4 – Frenagem Susp-AI 

 

Figura 11. 73 - Força normal da simulação brake_01 - Susp-AI 

 

 

Figura 11. 74 - Escorregamento lateral (slip) da simulação brake_01 - Susp-AI 
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Figura 11. 75 - Força normal da simulação brake_02 - Susp-AI 

 

Figura 11. 76 - Escorregamento lateral (slip) da simulação brake_02 - Susp-AI 

 

Figura 11. 77 - Força normal da simulação brake_03 - Susp-AI 
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Figura 11. 78 - Escorregamento lateral (slip) da simulação brake_03 - Susp-AI 

 

Figura 11. 79 - Força normal da simulação brake_04 - Susp-AI 

 

Figura 11. 80 - Escorregamento lateral (slip) da simulação brake_04 - Susp-AI 
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Figura 11. 81 - Força normal da simulação brake_05 - Susp-AI 

 

Figura 11. 82 - Escorregamento lateral (slip) da simulação brake_05 - Susp-AI 

 

Figura 11. 83 - Força normal da simulação brake_06 - Susp-AI 
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Figura 11. 84 - Escorregamento lateral (slip) da simulação brake_06 - Susp-AI 

 

Figura 11. 85 - Força normal da simulação brake_07 - Susp-AI 

 

Figura 11. 86 - Escorregamento lateral (slip) da simulação brake_07 - Susp-AI 
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Figura 11. 87 - Força normal da simulação brake_08 - Susp-AI 

 

Figura 11. 88 - Escorregamento lateral (slip) da simulação brake_08 - Susp-AI 

 

Figura 11. 89 - Força normal da simulação brake_09 - Susp-AI 
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Figura 11. 90 - Escorregamento lateral (slip) da simulação brake_09 - Susp-AI 

 

11.4 – Frenagem Susp-AD 

 

Figura 11. 91 - Força normal da simulação brake_01 - Susp-AD 

 

 

Figura 11. 92 - Escorregamento lateral (slip) da simulação brake_01 - Susp-AD 
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Figura 11. 93 - Força normal da simulação brake_02 - Susp-AD 

 

Figura 11. 94 - Escorregamento lateral (slip) da simulação brake_02 - Susp-AD 

 

Figura 11. 95 - Força normal da simulação brake_03 - Susp-AD 
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Figura 11. 96 - Escorregamento lateral (slip) da simulação brake_03 - Susp-AD 

 

Figura 11. 97 - Força normal da simulação brake_04 - Susp-AD 

 

Figura 11. 98 - Escorregamento lateral (slip) da simulação brake_04 - Susp-AD 
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Figura 11. 99 - Força normal da simulação brake_05 - Susp-AD 

 

Figura 11. 100 - Escorregamento lateral (slip) da simulação brake_05 - Susp-AD 

 

Figura 11. 101 - Força normal da simulação brake_06 - Susp-AD 
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Figura 11. 102 - Escorregamento lateral (slip) da simulação brake_06 - Susp-AD 

 

Figura 11. 103 - Força normal da simulação brake_07 - Susp-AD 

 

Figura 11. 104 - Escorregamento lateral (slip) da simulação brake_07 - Susp-AD 
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Figura 11. 105 - Força normal da simulação brake_08 - Susp-AD 

 

Figura 11. 106 - Escorregamento lateral (slip) da simulação brake_08 - Susp-AD 

 

Figura 11. 107 - Força normal da simulação brake_09 - Susp-AD 
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Figura 11. 108 - Escorregamento lateral (slip) da simulação brake_09 - Susp-AD 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


